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About this guide

Overview of this guide

The Administrator Guide for the Central Designer Administrator application provides step-by-step
instructions for configuring administration information using the options in the user interface. The
guide also provides:

o  Checklists that summarize the main administration activities.
e Reference information about rights.

e A glossary of terms.

Audience

This guide is for users of the Central Designer Administrator application, including:

o  User administrators
e System administrators

e (Catalog administrators
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Documentation

The product documentation is available from the following locations:

e Oracle Software Delivery Cloud (https://edelivery.oracle.com)—The complete
documentation set.

e My Oracle Support (https://support.oracle.com)—Relase Notes and Known Lssues.

e Oracle Technology Network (http://www.oracle.com/technetwork/documentation)—The
most current documentation set, excluding the Re/ease Notes and Known Issues.

All documents may not be updated for every Central Designer release. Therefore, the version
numbers for the documents in a release may differ.

Item Description

Release Notes The Release Notes document provides detailed information about the requirements,
enhancements, and fixed issues in the current release.

Known Issues The Known Issues document provides detailed information about the known issues
in this release, along with workarounds, if available.

Installation Guide 'The Installation Guide provides system requirements and instructions for installing
and upgrading the Oracle® Health Sciences Central Designer software and the
Oracle® Health Sciences Central Designer Administrator software.

Adpministrator The Adpinistrator Guide describes how to use the Oracle® Health Sciences Central
Guide Designer Administrator software to set up users, permissions, system
configuration parameters, and catalog defaults.

User Guide The User Guide introduces the study design environment in the Oracle® Health
Sciences Central Designer application and describes how to work as a study
design team in that environment, including how to:

e Work collaboratively.
e Maximize study design efficiency by reusing study objects.

e Manage collections of study objects.

InForm Design ~ The InForm Design Guide describes how to design a study for deployment to the
Guide InForm application.

Rules Reference  The Rules Reference Guide is a reference to the tools that are available for creating
Guide rule expressions, including:

e Study object properties.
e Functions.

e Constants.

e Data mappings.

e Methods, operators, and literals.
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About this guide

Item Description

Secure The Secure Confignration Guide provides an overview of the security features
Configuration provided with the Oracle® Health Sciences Central Designer application, including
Guide details about the general principles of application security, and how to install,

configure, and use the Central Designer application securely.

Third Party The Third Party Licenses and Notices document includes licenses and notices for
Licenses and third party technology that may be included with the Central Designer software.
Notices

Documentation accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program
website at http://www.oracle.com/pls/topic/lookuprctx=acc&id=docacc.
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If you need assistance

Oracle customers have access to support through My Oracle Support. For information, visit
http:/ /www.oracle.com/pls/topic/lookup?ctx=acc&id=info, or if you are hearing impaired, visit
http:/ /www.oracle.com/pls/topic/lookup?ctx=acc&id=trs.

Finding Central Designer information and patches on My Oracle Support

The latest information about the Central Designer application is on the Oracle Support self-service
website, My Oracle Support. Before you install and use the Central Designer application, check My
Oracle Support for the latest information, including Release Notes and Known Issues, alerts, white
papers, bulletins, and patches.

Creating a My Oracle Support account

You must register at My Oracle Support to obtain a user name and password before you can enter
the site.

1 Open a browser to https://support.oracle.com.
2 Click the Register link.

3 Follow the instructions on the registration page.

Finding information and articles

1 Sign in to My Oracle Supportt at https://support.oracle.com.

2 If you know the ID number of the article you need, enter the number in the text box at the top
right of any page, and then click the magnifying glass icon or press Enter.

3 To search the knowledge base, click the Knowledge tab, and then use the options on the page to
search by:

e Product name or family.

e Keywords or exact terms.

Finding patches
You can seatrch for patches by patch ID or number, product, or family.
1 Sign in to My Oracle Support at https://support.oracle.com.
2 Click the Patches & Updates tab.
3 Enter your search criteria and click Search.
4 Click the patch ID number.

The system displays details about the patch. You can view the Read Me file before downloading
the patch.

5  Click Download, and then follow the instructions on the screen to download, save, and install the
patch files.

Oracle® Health Sciences Central Designer 2.1 xiii
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Finding Oracle documentation

The Oracle website contains links to Oracle user and reference documentation. You can view or
download a single document or an entire product library.

Finding Oracle Health Sciences documentation

For Oracle Health Sciences applications, go to the Oracle Health Sciences Documentation page at
http:/ /www.oracle.com/technetwork/documentation/hsgbu-clinical-407519.html.

Note: Always check the Oracle Health Sciences Documentation page to ensure you have the most
up-to-date documentation.

Finding other Oracle documentation
1 Do one of the following:
¢ Go to http://www.oracle.com/technology/documentation/index.html.

e Go to http://www.oracle.com, point to the Support tab, and then click Product
Documentation.

2 Scroll to the product you need, and click the link.

Finding prerequisite software for Oracle Health Sciences applications

Xiv

Prerequisite software for Oracle Health Sciences applications is available from the following
locations:

e Download the latest major or minor release from the Oracle Software Delivery Cloud
(https://edelivery.oracle.com/).

For information on the credentials that are required for authorized downloads, click FAQs on the
main page of the Oracle Software Delivery Cloud portal.

e Download subsequent patch sets and patches from My Oracle Support
(https:/ /support.oracle.com).

To find patch sets or patches, select the Patches & Updates tab.

If a previous version of prerequisite software is no longer available on the Oracle Software Delivery
Cloud, log a software media request Service Request (SR). Previous versions of prerequisite software
are archived and can usually be downloaded. After you open an SR, you can check its status:

e  US customers: Call 1-800-223-1711.

e Outside the US: Check www.oracle.com/us/support/contact/index.html for your local Oracle
Support phone number.

For more information on logging a media request SR, go to My Oracle Support for Document
1071023.1: Requesting Physical Shipment or Download URL for Software Media
(https:/ /support.oracle.com/epmos/faces/DocumentDisplay?id=1071023.1).
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CHAPTER 1

Introduction to the Central Designer
Administrator and Central Designer
applications

In this chapter
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Chapter 1 Introduction to the Central Designer Administrator and Central Designer applications

About Central Designer applications

The Central Designer application provides a collaborative design environment that supports multiple
users and roles from any location.

There are two client applications:
e Central Designer—Used for collaborative study development.

e Central Designer Administrator—Used to set up users, permissions, system configuration
parameters, and catalog defaults.

An administrator must set up administration information before you can perform some tasks.

The system configuration consists of the database server, the application server, and the application
clients.

[Tr— Central Designer Administrator gmar ¢ bent
] P —
Central Designer H .g
application server A

Central Designer smart clients

DR I _““@
-

- Central Designer Adminkstrator smart client

Central Designer smart clients

Coritral Dagigrer Hoesnss UFFEPRIIBE  ..osioisssssssssre
databate erver
5
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About the Central Desigher Administrator application and
users

In the Central Designer Administrator application, you create and manage:
e Users

e Roles

e Collaboration

e Supported locales

e Custom properties

e Categories

e Keywords

e  Seccurity settings

e Deployment options

e System configuration settings
e In-place revision settings

Some tasks in the Central Designer application cannot be performed until the administration
information is set up correctly in the Central Designer Administrator application.

Other types of administration, including administering studies and libraries, are performed in the
Central Designer application. For more information, see the User Guide.

Users might have the following roles within their organization:

Note: The following roles are examples. You can create roles as needed for your organization.

e User administrator—A user administrator manages users, roles, and rights.

e System administrator—A system administrator manages system configuration options,
including supported locales, collaboration note types and task types, and custom properties.

e Catalog administrator—A catalog administrator manages the study object catalog and user
catalog by creating keywords and categories.

Oracle® Health Sciences Central Designer 2.1 3



Chapter 1 Introduction to the Central Designer Administrator and Central Designer applications

About the Central Designer application and users

The Central Designer application provides a collaborative environment for developing clinical studies
and addresses the need to significantly increase productivity in the study design process by:

e Providing one central environment for study design.
e Improving efficiency.
e  Facilitating reuse.

e Supporting internal and external standards.

User Description

Clinical data manager A user who is involved in the study design process.

Library administrator A user with library administration privileges for one or more
clinical areas.

Central Designer administrator ~ An IT representative who supports and maintains the application
from a technology and infrastructure perspective.

Study design team Users who implement a study. This team includes several roles
such as form designer, rule designer, and study workflow
designer.

Medical project manager A user who works with the CRF designer to create an annotated

study protocol, usually based on existing CRFs for the therapeutic
area. This user is concerned with the overall set of study
questions and logic, not the individual details of form design.

Statistician A user who interacts with study designers with respect to data
collection needs for analysis.

Translator A user who is responsible for translating text in clinical studies,
forms, items, and rule queries to a specified language.

4 Oracle® Health Sciences Central Designer 2.1
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Getting help

The Central Designer Administrator application provides the following ways to get help:
o Administrator Guide

e Press F1, and then click the area of the application for which you want more information. A
Help window appears with the relevant page displayed.

e Select Help > Central Designer Administrator Help to open the Adwinistrator Guide.
e Hover Help

If you hold your mouse pointer over a button, tab, or icon without moving it, a tool-tip appears
with a brief description of the item that you are pointing to.

If you need the version of the application, you can view it in the About Central Designer Administrator
dialog box. The dialog box also contains copyright information.

Oracle® Health Sciences Central Designer 2.1 5



Chapter 1 Introduction to the Central Designer Administrator and Central Designer applications

Central Designer Administrator terms

The Central Designer Administrator application uses the following terms.

Term Definition

User A person who works in the Central Designer or Central Designer
Administrator application.

Role A collection of rights. When a user is assigned to a role, the rights associated
with the role are granted to the user.

Right A predefined permission that controls access to a specific feature or activity
in the Central Designer client or Central Designer Administrator client and
that can be assigned to one or more roles.

Collaboration note A classification used to identify the type and purpose of a collaboration note.

type

Task type A classification used to identify the type of the task and the way the task is
used.

Supported locale A supported language or language variation.

Custom property A user-defined or default characteristic of a study object. The Central
Designer Administrator application includes some predefined custom

properties.

Keyword An identifier that is associated with users and study objects to facilitate more
powerful and efficient searches. A keyword can be system-generated or user-
defined.

Category A hierarchical grouping of keywords. You can create categories only from

existing keywords. A category can be automatically generated or manually
generated.

6 Oracle® Health Sciences Central Designer 2.1
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Troubleshooting issues with Help

If any of the tabs do not appear when you open the Help from the Help menu, add the name of the
application server to the list of trusted sites.

1 In Internet Explorer, select Tools > Internet Options.
2 Select the Security tab.

3 Select Trusted Sites, and click Sites.

4

In Add this Web site to the zone, type the address that the client application uses to connect to the
application server.

5 Click OK until you return to Internet Explorer.
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Workspaces and views

10

The Central Designer Administrator application window consists of:

Toolbars and a menu bat.
View pane.

The view that you select (Users (on page 26), Roles (on page 42), System Config (on page 49),
or Catalog (on page 95)) determines the information that appears. Some tasks can be performed
in the view pane.

View menu buttons.
When you click a view menu button, the associated workspace appears.
Workspace.

The appearance of the workspace depends on the view that is selected. Most tasks are performed
in the workspace.

Status icons.

Icons indicate information about the connection between the client computer and the
application server computer.
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Users, rights, and roles

An administrator sets up users and roles in the Central Designer Administrator application. When an
administrator creates a role, the administrator chooses:

e The scope of the role. A role can have a library, study, or application scope.
e The rights to associate with the role.

The scope of a role, rights assigned to the role, and teams determine whether users can perform
certain activities and view different application areas.

e Library scope—Roles created with the library scope become library teams in the Central
Designer application.

To perform activities in a library, you must be assigned to:
e A role with a library scope in the Central Designer Administrator application.
e The corresponding library team in the Central Designer application.

e Study scope—Roles created with the study scope become study teams in the Central Designer
application.

To perform activities in a study, you must be assigned to:
e A role with a study scope in the Central Designer Administrator application.
e The corresponding study team in the Central Designer application.

e Application scope—Activities associated with the application scope are always available to all
users, whether or not the users are assigned to teams. Roles created with the application scope
do not become teams in the Central Designer application.
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Object-level locking

The Central Designer Administrator application does not support object-level locking. If two or
more users are modifying the same component in the Central Designer Administrator application,
the changes of the person who saves last are stored in the database. Users can work in different areas

of the application (for example, one can create roles and another can work in the catalog) without
affecting each other.
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Logging on and off

To log on:

1 Navigate to the following address:
http:/ / <server name> / CentralDesignerInstall
where <server name> is the name of the application server computer.
2 Click the Start Central Designer Administrator link.
A dialog box appears, indicating that the application is starting.
The logon window appears.

3 Type your User name and Password.

Note: When an account is created in the Central Designer Administrator application, the
administrator can select an option that requires the user to change their password the next
time they log on. You might be prompted to change your password.

4 Click Log On.
The Central Designer Administrator application opens.
To log off and log on as a different user:
1  Select File > Log On as a Different User.
You are logged off from the application, and the logon window appears.
2 Type the new User name and Password, and click Log On.

The Central Designer Administrator application opens with the Users workspace selected.

To log off:

e Sclect File > Exit.
If you have unsaved changes, you are prompted to save them.

You are logged off, and the Central Designer Administrator application closes.

Oracle® Health Sciences Central Designer 2.1
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Saving and resetting in the Central Desigher Administrator
application

Some workspaces contain two buttons at the bottom-right corner:

e Reset—Clears unsaved data that has been entered in the workspace.

e Save—Saves the changes that you made in the workspace or tab.

Note: If you have made changes and select another button or tab, you are prompted to save
changes, discard changes, or cancel.
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Undoing and redoing one or more actions

You can undo and redo some actions:

e After you perform one or more actions that you can undo, a drop-down menu containing all
actions that can be undone appears next to the Undo button. A similar drop-down menu is
available for the Redo button.

e After you perform an action that cannot be undone or redone, the drop-down arrows on the
Undo and Redo buttons are removed, and you cannot undo or redo any previous action.

Note: If you undo or redo any action except the last one you performed, the action you select and
all actions that you performed after it are undone or redone.

To undo the last action you performed:

e On the general toolbar, click the Undo button.
The last action that you performed is undone.

To undo a series of actions:

e On the general toolbar, click the drop-down arrow next to the Undo button, and select the action
to undo.

The action and all undoable actions that you performed after it are undone.

To redo an action:

e On the general toolbar, click the Redo button.
The last action that you undid is redone.

To redo a series of actions:

e On the general toolbar, click the drop-down arrow next to the Redo button, and select the action
to redo.

The action and all redoable actions that you performed before it are redone.
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Checklist—Creating and configuring users and roles

Use the following checklist to create and configure users and roles, and to assign users to roles in the
Central Designer Administrator application.

Perform the steps in the order in which they are presented. Depending on how your company uses
the Central Designer application, you might not need to perform all steps.

M Workflow step Where to get more information

U 1 Logon to the Central Designer Logging on and off (on page 13).
Administrator application.

O 2 Create a role. You must provide a name and  Creating a role (on page 38).
description and choose a role scope (library,
study, or application scope).

Optionally, use a role that is available by
default with the application.

O 3  Assign rights to a role. The available rights ~ Assigning rights to a role (on page 40).
depend on the scope of the_rolfa. For Rights desctiptions (on page 111).
example, library roles contain rights that
control access to libraties.

U 4  Create a user. You must provide a user name, Creating a user (on page 20).
display name, and password.

O 5  Optionally, you can require the uset to Requiring users to change their
change the assigned password after the user  passwords (on page 22).
logs on to the Central Designer application
the first time.

O 6  Optionally, provide contact information for ~ Changing the contact information of a
the user. user (on page 23).

O 7  Select the languages in which the user is Specifying the language fluency skills

fluent.

In the Central Designer application,
translators see translation requests only for
languages in which they have been specified
as fluent.

You must specify language fluency
information before activating a uset.

Note: You select languages from a list of
supported locales that have been specified in
the Central Designer Administrator
application. For more information, see
Adding and removing a locale (on page
50).

of a user (on page 24).

18
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M Workflow step

Where to get more information

U 8  Associate a user with keywords or categories. Categorizing a user with keywords and
Central Designer users can search for users  categories (on page 25).
using keywords and categories.
Note: You can create additional keywords in
the Catalog workspace. For more
information, see Checklist— Creating
keywords and categories (on page 90).
U 9  Assignauser toarole: Assigning a single user to one or more
J/ 23).
e In the Users workspace, you can assign a roles (on page 23)
single user to multiple roles. or
e In the Roles workspace, you can assign ~ Assigning one or more usets to a single
multiple users to a single role. role (on page 40).
U 10 Activate the user. Activating the user allows  Activating, deactivating, and

the user to log on to the Central Designer
application.

terminating a user (on page 21).

Oracle® Health Sciences Central Designer 2.1
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Working with users

Creating a user

1
2

Click the Users button.

Right-click in the Users view, and select Create User, or press Ctrl+N.
The Create User dialog box appears.

Fill in the fields in the dialog box, and click OK.

The new user appears in the Users list, and the user properties appear in the workspace. The
yellow status icon indicates that the user is inactive.

For more information, see Create User and Copy User dialog boxes - Field descriptions (on
page 34).

Copying a user

20

A user created by copying an existing user has the same role assignments and language fluency skills
as the original user, but the new user does not have the same personal information and has an
inactive status. You must provide a new user name and password for the new user. After you copy a
user, you can modify the information of the new user.

Consider copying a user if you need to create multiple users who will perform the same kinds of
activities as an existing user.

1
2

Click the Users button.

Right-click in the Users view, and select Copy User, or press Ctrl+C.
The Copy User dialog box appears.

Fill in the fields in the dialog box, and click OK.

The new user appears in the Users list, and the user properties appear in the workspace. The
yellow status icon indicates that the user is inactive.

For more information, see Create User and Copy User dialog boxes - Field descriptions (on
page 34).
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Activating, deactivating, and terminating a user

You cannot activate a locked user or a user whose status has been set to terminated.
1  Click the Users button.
2 In the Users list, right-click a user, and select one of the following options:

e  Activate User (or press Ctrl+E)—The status of the user changes to active, and the color of the
status icon changes to green.

e Deactivate User (or press Ctrl+D)—The status of the user changes to inactive, and the color of
the status icon changes to yellow.

e Terminate User (or press Ctrl+T)—The status of the user changes to terminated, and the color
of the status icon changes to red.

Filtering and searching the Users list

The Users list in the Central Designer Administrator application displays all Central Designer and
Central Designer Administrator users and the status of each user.

To filter the Users list:
1 Click the Users button.
2 From the Filter drop-down list, select one of the following filters:
o Al
e Active
e Inactive
e TLocked
e Terminated
To search the Users list by user name:
1 Click the Users button.

2 In the Search field, begin typing the name of the user you want to find.

Note: The search field is case-sensitive.

As you type, an incremental search of the User Name field is performed, and the first user that
matches the text that you type is selected.

Refreshing the Users workspace
Refreshing the Users workspace reloads information from the database.

e On the general toolbar, click Refresh.
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Changing the display name of a user

The display name of a user appears in the title bar in the Central Designer application. The Display

Name field is searched when you search for a user in the Users Browser in the Central Designer

application.
1 Click the Users button.
2 In the Users list, select a uset.
The Users workspace appears.
3 Select the User Info tab.
4 In the Display Name field, type the correct display name.
5  Click Save.

Changing the password of a user

1
2

Click the Users button.

In the Users list, right-click a user, and select Change Password, or press Ctrl+P.
The Change Password dialog box appears.

Fill in the fields in the dialog box, and click OK.

Note: When you change a user password, the User must change password at next logon
checkbox is automatically selected. If you do not want to require the user to change the

password at the next logon, you can deselect the checkbox.

For more information, see Change Password dialog box - Field descriptions (on page 35).

Requiring users to change their passwords

1

2
3
4

22

Click the Users button.
In the Users list, select a user.
Select the User Info tab.

Select User must change password at next logon, and click Save.

The next time the user logs on to either the Central Designer or Central Designer Administrator

application, the user is prompted to change the password.
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Changing the contact information of a user

1
2

3
4

Click the Users button.

In the Users list, select a user.
The Users workspace appears.
Select the Personal Info tab.

Fill in or change the fields in the Personal Info tab as necessary, and click Save.

For more information, see Personal Info tab - Field descriptions (on page 33).

Viewing the rights granted to a user

1
2

Click the Users button.

In the Users list, select the user whose rights you want to view.
The Users workspace appears.

Select the User Roles tab.

Click View Rights (located below the Selected Roles list).

The Granted Rights list appeats to the right of the action lists, displaying all of the available
rights for all role scopes. The rights that have been granted to the user are selected. As you assign
the user to additional roles, the list is updated to show the rights that you grant.

Assigning a single user to one or more roles

In the Users workspace, you can assign a single user to one or more roles.

1
2

Click the Users button.

In the Users list, select the user that you want to assign to a role.
The Users workspace appears.

Select the User Roles tab.

In the Available Roles action list, select the role to which you want to assign the user, and click the
right arrow button.

The user is assigned to the role, and the role is added to the Selected Roles action list.

Optionally, if you want to see a list of rights that are granted to the user, click View Rights (located
below the Selected Roles list).

The Granted Rights list appears to the right of the action lists, displaying all of the available
rights for all role scopes. The rights that have been granted to the user are selected. As you assign
the user to additional roles, the list is updated to show the rights that you grant.

Optionally, assign the user to additional roles as necessary.

Click Save.

Oracle® Health Sciences Central Designer 2.1 23



Chapter 3 User administration

Removing a user assignment from one or more roles

1 Click the Users button.

2 In the Users list, select the user whose role assignment you want to remove.
The Users workspace appears.

3 Select the User Roles tab.

4 In the Selected Roles action list, select one or more roles whose assignments you want to remove
and click the left arrow button.

The Available Roles action list and the role assignments for the user are updated.

5 Click Save.

Changing the view of the Skills tab

The Skills tab in the Users workspace has two views, Categorized and Alphabetic.

View Description and example

Categorized view Skills are grouped under the name of the skill type.

For example, the Translation Services category contains the Language
Fluencies skill.

Alphabetic view Skills are in an alphabetical list without skill type information.

For example, only Language Fluencies, not Translation Services, is
included in the list.

g &
e On the Skills tab toolbar, click either the Categorized button ( o ) or the Alphabetic button ( Al ).

Specifying the language fluency skills of a user

Language fluency information is used to determine the ability of a user to translate information into
another language. You must specify locale information before activating a user.

You must specify at least one language fluency skill for each user, even for users who will not be
translating. The skill set of a user must include all locales in which the user will develop study
metadata, including the locale that is chosen as the default locale for a study, or, if a default locale is
not chosen, the regional setting for the computer. Otherwise, the user does not have access to all
functionality for the locale.

You cannot perform certain tasks in the Central Designer application until you have a language
fluency skill in your own language.

1 Click the Users button.
2 In the Users list, select the user whose skills you want to change.
The Users workspace appears.

3 Select the Skills tab.
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4 Click the ellipsis button (I:I) at the end of the LanguageFluencies ficld.
The Add Locale dialog box appears.

5 Select the locales in which the user is fluent, and click OK.

Note: You select languages from a list of supported locales that have been specified in the
Central Designer Administrator application. For more information, see Adding and removing
a locale (on page 50).

The locales are added to the LanguageFluencies field.
6  Click Save.

For more information, see Skills tab - Field descriptions (on page 34).

Categorizing a user with keywords and categories

You can categorize a user with keywords and categories to facilitate more efficient user searches in
the Central Designer application. You can create keywords and set up categories in the Catalog
workspace.

To categorize a user with one or more keywords or categories:
1 Click the Users button.
2 In the Users list, select a uset.
The Users workspace appears.
3 Select the Categorization tab.
4 Catalog the user with one or more keywords or categories:
e In the Associate with keywords area, select one or more keywords to use to categorize the user.

e In the Associate with categories arca, select one or more categories to use to categorize the
user.

5 Click Save.

For more information, see Categorization tab - List descriptions (on page 34).
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About the Users workspace

In the Users workspace, you perform user administration, which consists of:

e  Creating new users and changing user information, including contact information, language
fluency skills, and associated keywords and categories.

e  Activating, deactivating, and terminating users.
e  Assigning a user to one or more roles.

e Viewing, sorting, and filtering the list of Central Designer and Central Designer Administrator
users.

For more information, see Users view - Option descriptions (on page 32).

User Info tab
In the User Info tab of the Users workspace, you can manage user passwords and display names.
To open the User Info tab:

1 Click the Users button.
2 Select a user.
The Users workspace appears, with the User Info tab selected by default.

For more information, see User Info tab - Field descriptions (on page 32).

Personal Info tab
In the Personal Info tab of the Users workspace, you can change the contact information of a user.
To open the Personal Info tab:

1 Click the Users button.
2 Seclect a uset.

The Users workspace appears.
3 Select the Personal Info tab.

For more information, see Personal Info tab - Field descriptions (on page 33).

User Roles tab
In the User Roles tab of the Users workspace, you:

o View the rights granted to a user (on page 23).
o Assign a single user to one or more roles (on page 23).

® Remove user assignment ffom one or more roles (on page 24).

26 Oracle® Health Sciences Central Designer 2.1



Administrator Guide

To open the User Roles tab:

1  Click the Users button.

2 Select a user.

The Users workspace appears.

3 Select the User Ro

les tab.

Illustration of the User Roles tab

User Roles tab

Uzer Info | Perzanal Infa

Available roles:
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|
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1—Available roles that can be assigned to the user selected in the Users list.

2—Select a role, and click a button to move it to the other list.

3—Click View Rights to see the rights that are assigned to the selected role.

4—Roles that are assigned to the selected user.

5—View rights that

are assigned to the selected role.

For more information, see User Roles tab - List descriptions (on page 34).
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Skills tab

28

In the Skills tab of the Users workspace, you specify user language fluency skills. Language fluency
information is used to determine the ability of a user to translate information into another language.
For example, some ateas of the Central Designer application that require translation skills include:

e  Study event short title.

e Form short title.

e Jtem Question and Short Question.
e Codelist item label.

e  Query text.

e  Email text.

e [Layout text.

You must specify at least one language fluency skill for each user, even for users who will not be
translating. The skill set of a user must include all locales in which the user will develop study
metadata, including the locale that is chosen as the default locale for a study, or, if a default locale is
not chosen, the regional setting for the computer. Otherwise, the user does not have access to all
functionality for the locale.

You cannot perform certain tasks in the Central Designer application until you have a language
fluency skill in your own language.

To open the Skills tab:
1 Click the Users button.
2 Select a user.
The Users workspace appears.
3 Select the Skills tab.

For more information, see Skills tab - Field descriptions (on page 34).
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Categorization tab

In the Categorization tab of the Users workspace, you associate a user with keywords and categories.

A keyword is an identifier that is associated with users and study objects to facilitate more powerful
and efficient searches. A keyword can be system-generated or user-defined.

e System keywords are keywords that are installed by default with the Central Designer application
or that an administrator creates in the Central Designer Administrator application.

e  User keywords are keywords that a Central Designer user creates.

A category is a hierarchical grouping of keywords. You can create categories only from existing
keywords. A category can be automatically generated or manually generated.

e  Automatically generated categories are categories that automatically catalog study objects by
auditing information (for example, the study object type, original author, creation date, and
library in which the study object was created).

e Manually generated categories are categories that you create by dragging keywords to the
Categories tree.

To open the Categorization tab:
1  Click the Users button.

2 Select a user.

3 Select the Categorization tab.

For more information, see Categorization tab - List descriptions (on page 34).

Statuses of users

Every Central Designer and Central Designer Administrator user is listed in the Users list (located in
the Users view, to the left of the Users workspace). User status is represented by an icon.

User status Description Icon

Active Active users can log on to and use the Central Designer and Central Green circle
Designer Administrator applications.

You can deactivate or terminate an active uset.

Inactive Inactive users cannot log on to either the Central Designer or Yellow circle
Central Designer Administrator application.

You can activate or terminate an inactive user.

Terminated  Terminated users cannot log on to either the Central Designer or ~ Red circle
Central Designer Administrator application.

A terminated user can never be activated or deactivated.

If you terminate a user account, you can never use the account
again. If you need to use a terminated account, copy and paste the
terminated account, and give the account a different name.
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User status Description Icon

Locked Locked users cannot log on to either the Central Designer or Lock
Central Designer Administrator application.

A locked user account or system user account is unlocked after the
amount of time configured in the System lockout timeout or User
lockout timeout settings. You can activate or deactivate a locked
user account.

Note: Users can log on only when they have the required rights that allow them to log on.

About assighing users to roles

You can assign users to roles in both the Users and Roles workspaces. When you assign a user to a
role, you authorize the user to assume the role in the studies or libraries where the user is a member
of the corresponding team.

e A user assigned to a study role is granted the rights associated with the role only in studies where
the user is also a member of the study team. For example, if a user is assigned to the Rule
Creation study role in the Central Designer Administrator application, the user must also be a
member of the Rule Creation study team for a study to create rules in the study.

e A user assigned to a library role is granted the rights associated with the role only in libraries
where that user is also a member of the library team. For example, if a user is assigned to the
Librarian library role in the Central Designer Administrator application, the user must be a
member of the Librarian library team for a library (in the Central Designer application) to work
in the library.

Note: You assign users to roles in the Central Designer Administrator application and to study and
library teams in the Central Designer application.
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You can assign a single user to multiple roles, and assign multiple users to a single role, as shown in
the following illustration.

Assigning users to roles

o 1a€

|
|
|
| 1 Role A | 2 |
| User Hl | |
| |_RDI£B | User |

1—In the Users workspace, you can assign a single user to multiple roles.

2—1In the Roles workspace, you can assign multiple users to a single role.

To grant rights to a user, you must first assign rights to a role, and then assign the user to that role.

Default users
Archiveimporter user

The archiveimporter user is created during installation. When study objects in an archive file refer to
a user that does not exist in the target database, archiveimporter is inserted for the uset's name in the
Central Designer application. For example, if the user JohnSmith modified a study object in the
archive but does not exist in the database, the History Viewer lists archiveimporter in place of
JohnSmith after the archive is imported.

By default, the archiveimporter user has no rights. The password for this user is the same password
as the one you select for the system user during the Central Designer installation.

Note: Oracle recommends that you do not terminate this user.

System user

After your initial installation, log on using the system user account, the initial administrator account,
and create user accounts. After you have added users, you can terminate or keep the system user
account.

e Ifyou keep it, Oracle recommends associating it with a person in your organization for auditing
purposes.

e If you terminate it, first create another user account with the Perform all activities in all
studies and libraries ("'super-user') right, which is available for application scope roles. At
least one user should always have this right assigned.
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Option descriptions for the Users view and workspace

Users view—Option descriptions

Option Description

Filter Options are:
o Al
e Active

e Inactive
e Terminated
e T.ocked

For more information about how to use the user filter, see Filteting and
searching the Users list (on page 21).

Search Search for a user by User Name. As you type, an incremental search of the User
Name field is performed, and the first user that matches the text that you type is
selected.

For more information about how to search the Users list, see Filteting and
searching the Users list (on page 21).

User Name Name that is entered in the User Name field when a user is created. The User
Name is used to log on to the Central Designer or Central Designer Administrator
application. This field is searched when you search for a user in the Central
Designer Administrator application.

Display Name Name that is entered in the Display Name field when a user is created. The
Display Name appears in the title bar in the Central Designer application. The
Display Name field is searched when you search for a user in the Users Browser in
the Central Designer application.

User Info tab—Field descriptions

Field Description

User Name User name for logging on to the Central Designer or Central Designer
Administrator application.

Note: You cannot modify a user name after the user has been created.

Display Name Name that appears in the title bar in the Central Designer application. The
Display Name field is searched when you search for a user in the Users
Browser in the Central Designer application.
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Field Description

Status Options are:
e Al
e Active

e Inactive
e Terminated
e T.ocked

Note: You can modify the status of a user in the Users list only.

User must change e Selected—User must create a new password the next time they log on
password at next logon to the Central Designer or Central Designer Administrator application.

e Not selected—User is not required to change the password that you
created.

Personal Info tab—Field descriptions

Field Description Keyboard shortcut
Title User title, such as Mrs., Ms., or Mr. Alt+T
Position User job title. Alt+N
First Name User full name. Alt+S
Last Name Alt+L
Email User email address. Alt+M
Company User company. Alt+C
Department User department. Alt+R
Address User mailing address. Alt+D
City Alt+l
Postal Code Alt+P
State/Province Alt+V
Country Alt+U
Telephone User telephone number. Alt+0
Mobile User mobile telephone number. Alt+B
Fax User fax number. Alt+X
Pager User pager number. Alt+G
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User Roles tab—List descriptions

List Description
Available Roles Roles that are not associated with the selected uset.
Selected Roles Roles that are associated with the selected user.

Skills tab—Field descriptions

Field Description

Language Fluencies Languages in which the user is fluent. A user must be designated as fluent
in a language in order to translate information into that language in the
Central Designer application.

Categorization tab—List descriptions

List Description
Associate with keywords Selected keywords are associated with the user.
Associate with categories Selected categories are associated with the user.

Create User and Copy User dialog boxes—Field descriptions

Field Description

User Name Name that is entered in the User Name field when a user is created. The
User Name is used to log on to the Central Designer or Central Designer
Administrator application. This field is searched when you search for a user
in the Central Designer Administrator application.

Note: You cannot modify a user name after the user has been created.

Display Name User name that appears in the title bar in the Central Designer application.
The Display Name field is searched when you search for a user in the Users
Browser in the Central Designer application.

Password User password for logging on.

Confirm Password ~ User password, repeated for confirmation purposes.
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Change Password dialog box—Field descriptions

Field Description

New Password ~ New password for the user for logging on to the Central Designer or Central
Designer Administrator application.

Confirm New password for the user, repeated for confirmation purposes.
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Working with roles

Refreshing the Roles workspace
Refreshing the Roles workspace reloads information from the database.

e On the general toolbar, click Refresh.

Creating a role

You cannot modify the scope of a role after it has been created.
1 Click the Roles button.
2 Click Create Role.
or
Right-click within the Roles list, and select Create Role.
or
Press Ctrl+N.
The Create Role dialog box appears.
3 Fillin the fields in the dialog box, and click OK.
The role is added to the Roles list, and details for the role appear in the Roles workspace.
4 In the Roles workspace, define the properties, rights, and users associated with the role:
a  In the Properties tab, fill in the fields.
b  In the Rights tab, select one or more rights to be associated with the role.
¢ In the Users tab, select one or more users to assign to the role.
5  Click Save.

For more information, see:
Create Role dialog box - Field descriptions (on page 46).
Properties tab - Field descriptions (on page 45).

List descriptions for the Users tab (on page 406).

Deleting a role

1  Click the Roles button.

2 In the Roles list, right-click the role you want to delete, and then select Delete Role, or press
Delete.

3 Click Save.

Note: A DesignerAdministrator role comes with the application by default and cannot be
deleted.
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Copying a role

When you copy a role, the new role has the same rights and properties as the existing role but has a
unique name. You can modify the rights and properties of a role that is created by copying another
role. Consider copying a role if you need to create several similar roles.

1  Click the Roles button.
2 In the Roles list, select a role.
The Roles workspace appears.
3 Right-click the role, and select Copy Role.
or
On the toolbar, click Copy Role.
of
Press Ctri+C.

The new role appears in the Roles list with the name of NewRole. All other properties, rights,
and users from the original role are copied to the new role.

4 In the Name field, type a name for the role.

5 Modity the properties, rights, and users for this role as necessary:
a  In the Properties tab, fill in the fields.
b  In the Rights tab, select one or more rights to be associated with the role.
¢ In the Users tab, select one or more users to assign to the role.

6 Click Save.

For more information, see:
Properties tab - Field descriptions (on page 45).

Users tab - List description (on page 406).

Modifying the name or description of a role

You cannot modify the scope of a role after it has been created.

1 Click the Roles button.

2 In the Roles list, select the role whose properties you want to modify.
The Roles workspace appears.

3 Select the Properties tab.

4 Modify the information in the Name or Description field as necessary, and click Save.
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Assigning rights to a role

1  Click the Roles button.

2 In the Roles list, select a role.
The Roles workspace appears.

3 Select the Rights tab.

4 Select the rights to assign to the role. If you select a named set of rights, all of the associated
rights listed below the group name are also selected.

5 Click Save.

Removing rights from a role

1 Click the Roles button.
2 In the Roles list, select a role.
The Roles workspace appears.
3 Select the Rights tab.
4 Deselect the rights that you want to remove from the role.

5 Click Save.

Assigning one or more users to a single role

1 Click the Roles button.

2 In the Roles list, select a role.
The Roles workspace appears.

3 Seclect the Users tab.

4 In the Available Users action list, select a user, and click the right arrow button.

Note: To select more than one user, use Ctrl+click or Shift+click.

The user is added to the Selected Users action list and is assigned to the role.

5 Click Save.
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Removing a user from a role

1 Click the Roles button.

2 In the Roles list, select the role from which you want to remove a user.
The Roles workspace appears.

3 Select the Users tab.

4 In the Selected Users action list, select the user that you want to remove from the role and click
the left arrow button.

Note: To select more than one user, use Ctrl+click or Shift+click.

The user is moved to the Available Users action list.

5 Click Save.
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About the Roles workspace

In the Roles workspace, you perform role administration, which consists of managing tasks that users
perform in the Central Designer and Central Designer Administrator applications, assigning rights to
roles, and assigning roles to users. Tasks include the following:

e  Creating, copying, and deleting roles. Roles created in the Central Designer Administrator
application appear as teams in the Central Designer application.

e Modifying the name and description of a role.
e Assigning rights to a role.

e Assigning one or more users to a role.

The Roles workspace contains:

e A list of all Central Designer roles.

e Tabs in which you customize role information. The tabs appear only after you select a role.

Properties tab

Rights tab

42

In the Properties tab of the Roles workspace, you modify the name or description of a role.
To open the Properties tab:
1 Click the Roles button.
2 In the Roles list, select a role.
The Roles workspace appears with the Properties tab selected by default.

For more information, see Properties tab - Field description (on page 45).

In the Rights tab of the Roles workspace, you can:

o Assign rights to a role (on page 40).
® Remove tights from a role (on page 40).

You can configure rights for library, study, and application roles. The rights that appear in the Rights
tab depend on the scope of the selected role (library, study, or application). For example, the rights
associated with a library role are different from the rights associated with a study role.

To open the Rights tab:

1 Click the Roles button.
2 In the Roles list, select a role.
The Roles workspace appears.

3 Select the Rights tab.
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About assighing users to roles

You can assign users to roles in both the Users and Roles workspaces. When you assign a user to a
role, you authorize the user to assume the role in the studies or libraries where the user is a member
of the corresponding team.

e A user assigned to a study role is granted the rights associated with the role only in studies where
the user is also a member of the study team. For example, if a user is assigned to the Rule
Creation study role in the Central Designer Administrator application, the user must also be a
member of the Rule Creation study team for a study to create rules in the study.

e A user assigned to a library role is granted the rights associated with the role only in libraries
where that user is also a member of the library team. For example, if a user is assigned to the
Librarian library role in the Central Designer Administrator application, the user must be a
member of the Librarian library team for a library (in the Central Designer application) to work
in the library.

Note: You assign users to roles in the Central Designer Administrator application and to study and
library teams in the Central Designer application.

You can assign a single user to multiple roles, and assign multiple users to a single role, as shown in
the following illustration.

Assigning users to roles

1—In the Users workspace, you can assign a single user to multiple roles.

2—In the Roles workspace, you can assign zultiple users to a single role.

To grant rights to a user, you must first assign rights to a role, and then assign the user to that role.
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Users tab
In the Users tab of the Roles workspace, you can:

e Assign one or more users to a single role (on page 40).

e  Remove a user from a role (on page 41).

Note: A user assigned to a role has all of the rights associated with that role.

To open the Users tab:

1  Click the Roles button.

2 In the Roles list, select a role.
The Roles workspace appears.

3 Select the Users tab.

For more information, see Users tab - List descriptions (on page 46).
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Option descriptions for the Roles view and workspace

Properties tab—Field descriptions

Field Description

Name Name of the role.
Description Description of the role.
Scope Scope of the role:

e Library—A user assigned to a library role is granted the rights
associated with the role only in libraries where that user is also a
member of the library team. For example, if a user is assigned to the
Librarian library role in the Central Designer Administrator
application, the user must be a member of the Librarian library team
for a library (in the Central Designer application) to work in the
library.

e Study—A user assigned to a study role is granted the rights associated
with the role only in studies where the user is also a member of the
study team. For example, if a user is assigned to the Rule Creation
study role in the Central Designer Administrator application, the user
must also be a member of the Rule Creation study team for a study to
create rules in the study.

e Application—A user assigned to an application role is granted all of
the rights that are associated with the role, without restrictions. For
example, a user who has the right to create users can always create
users.

Note: You assign users to roles in the Central Designer Administrator
application and to study and library teams in the Central Designer
application.

For more information about role scopes and the rights they grant, see
Rights descriptions (on page 111).

Approval Policies

section
Approval Role Reserved for future use.
Approval Meaning Reserved for future use.

Rights tab—Option descriptions

The Rights tab in the Roles workspace has rights that you can associate with a role. For descriptions
of the rights, see Rights descriptions (on page 111).
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Users tab—List descriptions

List Description

Available Users

All users that have been created in the Central Designer Administrator
application but are not assigned to the selected role.

Selected Users

All users that have been assigned to the selected role.

Create Role dialog box—Field descriptions

Name Name of the role.
Description Description of the role.
Scope Scope of the role:

Library—A user assigned to a library role is granted the rights associated with
the role only in libraries where that user is also a member of the library team.
For example, if a user is assigned to the Librarian library role in the Central
Designer Administrator application, the user must be a member of the
Librarian library team for a library (in the Central Designer application) to
work in the library.

Study—A user assigned to a study role is granted the rights associated with
the role only in studies where the user is also a member of the study team. For
example, if a user is assigned to the Rule Creation study role in the Central
Designer Administrator application, the user must also be a member of the
Rule Creation study team for a study to create rules in the study.

Application—A user assigned to an application role is granted all of the
rights that are associated with the role, without restrictions. For example, a
user who has the right to create users can always create users.

Note: You assign users to roles in the Central Designer Administrator application
and to study and library teams in the Central Designer application.

For more information about role scopes and the rights they grant, see Roles
workspace—Right desctiptions (on page 112).
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Default roles

Rights assighed to the StudyDesigner role

This role is an Application role, so the assigned rights are all Application rights.

For rights descriptions, see Rights descriptions (on page 111).

Rights group Selected rights

Application Administration Log on to the Central Designer application.
(on page 113)

(Right group is not selected.)

Catalog Administration (on All rights within this category are selected.
page 113)
Search (on page 117) All rights within this category are selected.

Rights assighed to the StudyAdministrator role

This role is an Application role, so the assigned rights are all Application rights.

For rights descriptions, see Rights descriptions (on page 111).

Rights group Selected rights
Application Administration (on  Log on to the Central Designer software.
page 113)

(Right group is not selected.)

Study Administration (on page All rights within this category are selected.

118)
Libraty Administration (on page  All rights within this category are selected.
1106)
Catalog Administration (on page  All rights within this category are selected.
113)
Search (on page 117) All rights within this category are selected.

Rights assighed to the DesignerAdministrator role

All Application rights are selected. For more information, see Application roles—Rights
descriptions (on page 113).
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Working with supported locales

Checklist—Setting up in Central Designer Administrator for translating text
strings

Perform these steps as needed, in any order.

Note: Perform each step in this checklist in the Central Designer Administrator application.

M Workflow step Where to get more information

O 1 Inthe System Config > General > System Configuration administration (on
Supported Locales area, select each page 49).
locale that you expect to be supported
by studies designed in the Central
Designer application.

O 2 Inthe Users > User Roles area, assign ~ User administration (on page 17).
roles that include the Translate Study
Resources right to users who are
responsible for translating.

O 3 Inthe Users > Skills area, assign User administration (on page 17).
language fluency skills to users who are
responsible for translating.

Adding and removing a locale

You can add and remove one or more locales at the same time.
To add one or more locales:

1 Select System Config.

2 In the General section, click the Supported Locales link.
The Supported Locales workspace appears.

3 Click Add (located in the upper-right corner).
The Add Locale dialog box appears.

4 Select the checkboxes next to the locales that you want to add to the supported locales list, and
click OK.

The locales are added to the list.
5 Click Save.
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To remove one or more locales:

1  Select System Config.

2 In the General section, click the Supported Locales link.
The Supported Locales workspace appears.

3 Select the checkbox next to the locale you want to remove, and click Remove.
The locale is removed from the list.

4 Click Save.

Supported Locales workspace

In the Supported Locales workspace, you define the locales to support for study design. A locale is a
supported language or language variation.

You can design and deploy studies in every language and locale that is installed with the Microsoft
Windows operating system, but only the languages and locales that you specify are available when a
study is created in the Central Designer application.

Note: You must select at least one locale to design studies.

To open the Supported Locales workspace:

1  Click the System Config button.
2 Under General, click Supported Locales.

For more information, see Supported Locales workspace - Field descriptions (on page 51).

Supported Locales workspace—Field descriptions

Field Description

Locale A supported language or language variation.
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Working with target applications

Targets workspace

In the Targets workspace, you enable and disable available target applications. A target application is
an application to which you deploy a Central Designer study. For example, you can use the Central
Designer application to design a study and deploy that study to the InForm application. The InForm
application is the target application.

To open the Targets workspace:

1  Click the System Config button.
2 Under General, click Targets.

For more information, see Targets wortkspace—Field descriptions (on page 52).

Targets workspace—Field descriptions

Field Description

Name Name of the installed target application.

Version Installation version associated with the target application. This field is
incremented each time a new version of the target application is installed.

Enabled If selected, allows study objects for the target application to appear in the
Central Designer application.
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Working with sponsors

Sponsors workspace

In the Sponsors workspace, you create sponsors, which are then available in the Central Designer
application to be assigned to studies. You also can delete sponsors and import and export sponsor
information. The sponsor and sponsor detail information you create in the Central Designer
Administrator application appears in the Central Designer application.

When Central Designer users create new sponsors and detail information, the sponsor names, but
not the detail information, appear in the Central Designer Administrator application.

Central Designer users also can edit sponsor and sponsor details that you create. The changes they
make do not appear the Central Designer Administrator application.

To open the Sponsors workspace:
1  Click the System Config button.

2 Under General, click Sponsors.

For more information, see Sponsors workspace—Field descriptions (on page 54)

Creating a sponsor

1  Select System Configuration.
2 In the General section, select Sponsors.
The Sponsors workspace appears.

3 Fillin the fields for the organization that is sponsoring the study.

Note: The only required field is the Sponsor Name.

Deleting a sponsor

1  Select System Configuration.

2 In the General section, select Sponsors.
The Sponsors workspace appears.

3 Select the sponsor to delete.

4 Click Delete.
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Importing sponsor information

If a study object in the CSML data you are importing has the same identifier as an object in the study,
the existing object is not deleted. Instead, a new study object is created and its version is
incremented.

1  Select System Configuration.
2 In the General section, select Sponsors.
The Sponsors workspace appears.
3 Click Import.
The Open dialog box appears.
4 Navigate to the CSV file that contains the sponsor information.

5  Click Open.

Exporting sponsor information

1  Select System Configuration.
2 In the General section, select Sponsors.
The Sponsors workspace appears.
3 Select the sponsor to export.
4 Click Export.
The Save As dialog box appears.
5 Navigate to the location in which to save the file and do the following:
a  Type a name for the file.
b  From the Save As type drop-down list, select CSV.

c Click Save.

Sponsors workspace—Field descriptions

54

Option Description

Sponsor Name Name of the organization that is sponsoring the study.
Note Additional information.

Program Name of the study.

Therapeutic area Medical area that is being investigated by the study.
Address 1 Sponsor’s street address.

Address 2 Additional address information.

City City.

State State (United States).
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Option Description

Zip code Zip code (United States).

Province Province (outside the United States).
Postcode Postcode (outside the United States).
Country Country.

Phone Telephone number.

Alt phone Alternate telephone number.

Fax Fax number.

Email address Email address.
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Working with system settings

System Settings workspace

System settings specify information that is specific to a specific InForm release. These settings are
installed when the Central Designer application is installed.

In the System Settings workspace, you can view, export, import, and delete system settings, but you
cannot modify them. Central Designer users can modify system settings and assign them to studies.

To learn more about the system settings, sece System Settings tab of the Administration Editor—
Option descriptions in the InForm Design Guide.

To open the System Settings workspace:

1
2

Click the System Configuration button.

Under General, click System Settings.

Importing, exporting, and deleting system settings

56

To import system settings from a file:

1
2

Select System Configuration.

Under General, select System Settings.

The System Settings workspace appears.

Click Import.

The Open dialog box appears.

Navigate to the location of the XML file that contains the system settings, and select it.

Click Open.

Note: If system settings already exist for an InForm release, you must delete the settings
before you can import other settings for the same release.
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To export system settings to a file:

1  Select System Configuration.
2 Under General, select System Settings.
The System Settings workspace appears.
3 From the Settings drop-down list, select the InForm release to export.
4 Click Export.
The Export dialog box appears.
5 Navigate to the location in which to save the fie, and do the following:
a  Type a name for the file.
b From the Save as type drop-down list, select XML.
¢ Click Save.

To delete system settings:

1  Select System Configuration.
2 Under General, select System Settings.
The System Settings workspace appears.
3 From the Settings drop-down list, select an InForm release.
4 Click Delete.
A confirmation dialog box appears.

5 Click OK.
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Working with in-place revision settings

In-place Revisions workspace

In the In-place Revisions workspace, you select whether to remove IPR configurations from studies
after the studies are deployed successfully to a LIVE deployment instance. Additionally, you can
configure whether protected and locked IPR configurations will also be removed.

Note: The settings in the In-place Revisions workspace apply only to automated deployments.

To open the In-Place Revisions workspace:

1  Click the System Configuration button.

2 Under General, click In-Place Revisions.

In-place Revisions workspace—Option descriptions

Description Default

Remove all IPR configurations after When selected, IPR configurations are ~ Not selected.

successful deployment to LIVE removed from studies after successful
deployment instance deployments to the LIVE deployment
instance.
Include protected IPR When selected, protected IPR Not selected.
configurations configurations are also removed from

studies after successful deployments to
the LIVE deployment instance.

Include locked IPR configurations ~ When selected, locked IPR Not selected.
configurations are also removed from
studies after successful deployments to
the LIVE deployment instance.
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Working with note types and task types

Adding, modifying, and deleting a collaboration note type

If collaboration notes that are based on a collaboration note type exist, you cannot delete the
collaboration note type.

To add a collaboration note type:

1
2

3

Select System Config.
In the Collaboration section, click the Note Types link.

The Note Types workspace appears, and information about existing collaboration note types
appears, followed by a blank row.

Fill in the fields in the blank row, and click Save.

To modify a collaboration note type:

1
2

3
4
5

Select System Config.
In the Collaboration section, click the Note Types link.

The Note Types workspace appears, and information about existing collaboration note types
appears, followed by a blank row.

Select the type that you want to modify.
For the selected type, click in a field and modify the information as necessary.

Click Save.

To delete a collaboration note type:

1
2

3

Select System Config.
In the Collaboration section, click the Note Types link.

The Note Types workspace appears, and information about existing collaboration note types
appears, followed by a blank row.

Right-click the type you want to delete, and select Delete Row.

For more information, see Note Types workspace - Field desctiptions (on page 61).

Adding, modifying, and deleting a task type

If tasks that are based on a task type exist, you cannot delete the task type.

To add a task type:

1
2

Select System Config.

In the Collaboration section, click the Task Types link.

The Task Types workspace appears. It contains information about existing task types, followed

by a blank row.

Fill in the fields in the blank row, and click Save.
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To modify a task type:

1  Select System Config.
2 In the Collaboration section, click the Task Types link.

The Task Types workspace appears. It contains information about existing task types, followed
by a blank row.

3 Select the type that you want to modify.

4 For the selected type, click a field, and modify the information as necessary.
5 Click Save.

To delete a task type:

1 Select System Config.

2 In the Collaboration section, click the Task Types link.

The Task Types workspace appears. It contains information about existing task types, followed
by a blank row.

3 Right-click the type you want to delete, and select Delete Row.

For more information, see Task Types workspace - Field descriptions (on page 62).

Note Types and Task Types workspaces

Note Types workspace

In the Note Types workspace, you define collaboration note types. A collaboration note type is a
classification used to identify the type and purpose of a collaboration note. For example, you can use
an Informational note type to create notes that provide information about a study object.

To open the Note Types workspace:

1  Click the System Config button.
2 Under Collaboration, click Note Types.

For more information, see Note Types workspace - Field descriptions (on page 61).
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Task Types workspace

In the Task Types workspace, you create task types. A task type is a classification used to identify the
type of the task and the way the task is used. For example, you can use a Create Form task type for
assigning form creation work.

Definitions of task types
For each task type, you define:

e A classification, which identifies the purpose of a task. The options are Standard and Translation.
e A study or library team to which tasks of that type are assigned by default.

e Tor Standard tasks, specifying a team is optional, and Central Designer users can override
the default assignment.

e For Translation tasks, you must specify a team, and Central Designer users cannot override
the assignment. In the Central Designer application, only the users with the language fluency
skills for the requested translation work can view the translation task.

Note: Study and library roles appear as study and library teams in the Central Designer
application.

Sample task types

You can choose the level of detail that you need for task types. For example, you can have a generic
Work request task type, or you can create specific types such as:

e Rule design
e Layout design
e Translation

If people frequently require clarification about tasks that are assigned to them and you need to track
the requests for additional information, consider creating a Clarification task type that people can
use to obtain additional information.

To open the Task Types workspace:

1  Click the System Config button.
2 Under Collaboration, click Task Types.

For more information, see Task Types workspace - Field descriptions (on page 62).

Note Types workspace—Field descriptions

Field Description

Name Name of the collaboration note type.

Description Description of the collaboration note type.
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Task Types workspace—Field descriptions

Field Description

Name Name of the task type.
Description Description of the task type.
Task Classification Classification of the task.

e Standard—Used for all non-translation tasks assigned to an
individual or team.

e Translation—Used for tasks that request translation of a study
object into one or more languages.

Assigned To Study or library team to which tasks of this type are assigned by default.

Notes:

e Study and library roles appear as study and library teams in the
Central Designer application.

e The default team for translation tasks cannot be overridden in the
Central Designer application.

e For translation tasks, members of the team see a task only if they are
fluent in the language to which the study object needs to be
translated.
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Working with custom properties

Adding, modifying, and removing a custom property

You can add a custom property to a grouping and remove a custom property from the grouping,.

If you remove a custom property, the property is removed from the Properties Browser in the
Central Designer application and is no longer associated with any study objects for which the
property value was assigned. Oracle recommends that you do not delete custom properties.

You must not delete InForm or Clintrial custom properties, or deployment is likely not to
succeed.

Do not modify InForm or Clintrial custom properties or groupings.

You cannot rename custom properties or groupings.

To add a custom property:

1
2

4

Select System Config.
In the Customization section, click the Custom Properties link.
The Custom Properties workspace appears.

In the Custom Properties list, right-click a grouping, and select Add Custom Property, or press
Ctrl+N.

A new custom property appears in the Custom Properties list, and details for the custom
property appear in the workspace.

Fill in the fields in the workspace, and click Save.

To modify a custom property:

1
2

4

Select System Config.

In the Customization section, click the Custom Properties link.

The Custom Properties workspace appears.

Select a custom property.

The custom property appears in the Custom Properties workspace.

Modify the fields as necessary, and click Save.

To remove a custom property:

1
2
3
4

Select System Config.
In the Customization section, click the Custom Properties link.

Right-click a custom property, and select Remove, or press Delete.

Click Save.

For more information, see Custom Properties workspace - Field descriptions (on page 73).
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Adding and removing a grouping

You can create a grouping under a study object in the Custom Properties workspace. After you
create a grouping, you can add a custom property to the grouping.

Notes:

¢ Do not modify InForm or Clintrial custom properties or groupings.
e You cannot rename custom properties or groupings.

To add a grouping:

1 Select System Config.

2 In the Customization section, click the Custom Properties link.

The Custom Properties workspace appears.

[SM)

Right-click a study object, and select Add Grouping, or press Ctrl+N, and then type the name of the
grouping,.
or

Select a study object, and type the name of the grouping in the blank field in the Groupings grid in
the workspace.

4 Press Enter.

5 Click Save.

To remove a grouping:

1  Select System Config.

2 In the Customization section, click the Custom Properties link.
The Custom Properties workspace appears.

3 Right-click a grouping, and select Remove, or press Delete.

4 Click Save.

Moving, cutting, copying, and pasting a grouping

64

When you cut or copy and then paste a grouping that contains one or more custom properties, the
custom properties are copied or cut and then pasted with the grouping,.

To move a grouping:

1  Select System Config.

2 In the Customization section, click the Custom Properties link.
The Custom Properties workspace appears.

3 Drag a grouping from one study object to the other study object name.
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To cut or copy and then paste a grouping:

1  Select System Config.
2 In the Customization section, click the Custom Properties link.
The Custom Properties workspace appears.
3 Right-click a grouping, and then select either Copy (or press Ctrl+C) or Cut (or press Ctrl+X).
4 Right-click a study object, and select Paste, or press Ctrl+V.

The grouping is moved.

Custom Properties workspace

All study objects have standard properties for which you view, define, and modify values in the
Properties Browser.

If you want to provide additional information about a study object, then you create custom
properties in the Central Designer Administrator application. A custom property is a user-defined or
default characteristic of a study object. You can create custom properties for study designs, study
elements, study events, forms, items, codelists, codelist items, logical schemas, data sets, and data
series.

After an administrator creates custom properties for the study objects in the Central Designer
Administrator application, Central Designer users can define values for custom properties in the
Properties Browser in the Central Designer application.

Custom properties are organized in both applications by study object and then by grouping. A
grouping is a default or user-provided value used to organize custom properties of a study object.

For example, you can create a custom property that allows Central Designer users to select the
dictionary used to code an item. You can specify values for the dictionaries, and users can either
select a dictionary from a list or type a dictionary name.

Note: In the Central Designer application, all custom properties appear in the Categories tree, so
users can include custom properties and their values in search parameters.

To open the Custom Properties workspace:

1  Click the System Config button.
2 Under Customization, click Custom Properties.

Illustration of the Custom Properties workspace

The Custom Properties workspace displays context-sensitive information, depending on what you
select in the Custom Properties tree.
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Custom Properties pane
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1—When a study object is selected, the workspace displays the groupings created under the study
object. Groupings organize properties in the Properties Browser in the Central Designer
application.

2—When a grouping is selected, the workspace displays all custom properties created in the
grouping. Some custom properties are predefined.

3—When a custom property is selected, the workspace displays details related to the custom
property. You can define this information.

For more information, see Custom Properties workspace - Field descriptions (on page 73).

InForm and Clintrial custom properties

The following InForm and Clintrial custom properties are available by default in the Custom
Properties workspace.

Note: You must not delete InForm or Clintrial custom properties, or deployment is likely not to
succeed.

For a list of CDD and CIS custom properties, see CDD mapping properties and CIS mapping
properties (in InForm Design Guide).
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Study object Custom
property

Description and default values

Study Design ~ Sponsor

Name of the sponsor of the study.

Sponsor
Date

Date specified by the sponsor of the study.

Generic
Drug Name

Generic name for a drug.

Sponsor
Drug Name

Code name given to a drug by a sponsor.

Trade Drug
Name

Commercial name of a drug.

Study Design ~ Shared Form
Block Key

Block key to use for a shared form. You must use this property if
the block key in the Clintrial application is defined as a numeric
field. The block key that you specify overrides the internal text
block key (CommonCRF) that the Central Designer application
creates during deployment from the system RefName of the special
visit for shared forms.

Study Event Optional

True or False (default), indicating whether the formset (visit) is
optional or required.

Form Special Visits

Indicates if the study event holds a Screening or Enrollment form.

e None (Default; study event does not have a Screening or
Enrollment form).

e Screening.

e Enrollment.

Ttem
Required

True (default) or False, indicating whether the item is required.

SDV
Required

True (default) or False, indicating whether the item requires source
verification.
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Study object Custom Description and default values
property
Special Forms that have special processing in the InForm software.
Forms
e None
e Screening
e Enrollment

Patient Identification
Study Completion
(Available only in the NonClinical container) Reg Docs

(Available only in the NonClinical container) Visit Report

SDV Critical True (default) or False, indicating whether the item requires source

verification.
Item Display Determines the default behavior of an item when a layout is
Override generated.

ReadOnly—The item is visible but not editable.

Editable—The item is visible and editable by any user,
regardless of the rights assigned to the user.

Hidden—The item is not visible.

None—The item is visible to all users, and visible and editable
by any user who has the rights to view and/or edit the item.

Item True (default) or False, indicating whether the item is required for
Required data entry on the form to be complete.

SDV True (default) or False, indicating whether the item requites
Required source document verification.
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Study object Custom

Description and default values

property

Special
Fields

Fields used on the special forms for the InForm application.
e None—Field is not a special InForm field.
e Screening form:
= Initals
= DOB
=  Screening date
e Enrollment form: Patient No.
e Patient Identification form: Initials
e Study Completion form:
* Completion status
* Drop out reason
¢ Date of Visit form: DOV

¢ Randomization form: Randomization field

MinValue

Minimum value that the InForm application will allow to be typed
for the item.

MaxValue

Maximum value that the InForm application will allow to be typed
for the item.

MinProperty True or False, indicating whether MinValue is inclusive of the

number typed.

MaxProperty True or False, indicating whether MaxValue is inclusive of the

number typed.

SDV Critical True (default) or False, indicating whether the item is marked as

critical.

Codelist Item  Study
Completion
Status Items

Codelist items in the codelist for the Completion Status item on
the Study Completion form, which is used in reporting in the
InForm application to determine whether a subject dropped out of
a study. Options include:

e None—(default) The codelist item is not part of the codelist
for the Completion Status item.

e Complete Study (Study Completion)—Indicates that the
subject has completed the study.

¢ Incomplete Study (Study Completion)—Indicates that the
subject has not completed the study.
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70

Study object

Clintrial
custom
properties

Custom
property

Description and default values

Study Event

Repeats
Limit

Maximum number of times a block can repeat. Set to -1 for
unlimited repeats.

Form

Verifiable

Indicates whether the panel needs to be verified in the Clintrial
application.

e (0—(default) Verification is not required before data in the
panel can be validated.

e 1 Verification is required before data in the panel can be
validated.

Protected

Indicates if the panel is protected in the Clintrial application.
e (0—(default) Panel is not protected.

e 1—Panel is protected.

MaxRepeats

Maximum number of repeating records that are allowed in a page
section.

Type

Type of panel in the Clintrial application.

e 0—Type 0 panel (non-patient data).

e 1—(default) Type 1 panel (one record per patient).

e 2 Type 2 panel (more than one record per patient).

e 3—Type 3 panel (one record per patient visit).

e 4—Type 4 panel (more than one record per patient visit).

e 5 _Type 5 panel (subject enrollment).

Audit Start

Default audit start point for all protocols in the Clintrial database
instance.

e ENTRY—Auditing begins after data has been entered
interactively in a record.

e VERIFICATION—Auditing begins after data has been re-
entered to check the accuracy of the entry or, for batch-loaded
records, after data has been screened.

e VALIDATION—Auditing begins after a record has been
validated, regardless of whether the record passed or failed
validation.

e  VALIDITY—Auditing begins after a record has passed
validation.

e MERGE—Auditing begins after data has moved from the
update table to the data table.
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Study object Custom

Description and default values

property
Item SAS Name

Name of the item when data is sent to a SAS dataset through the
Clintrial SAS interface. This attribute must be no more than eight
characters, and it must conform to SAS requirements.

Required

e Selected—Value for the item must be supplied (for example,
by the data-entry operator, or as a derived item) in the Clintrial
application.

e Not selected—Value is not required in the Clintrial
application.

Note: If Required is True, Derived must be False. If Required is
False, Derived must be True.

Thesaurus

Name of the thesaurus used to code the item.

Derived

Indicates that the value of the item is calculated from a detrivation
associated with the panel.

Note: If Required is True, Derived must be False. If Required is
False, Derived must be True.

Min

Minimum value that can be entered for the value of the item in the
Clintrial application.

Max

Maximum value that can be entered for the value of the item in the
Clintrial application.
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Custom properties in the Central Designer application

A custom property created for a study object (for example, an item) appears in the Properties
Browser for all study objects of that type (in this case, all items).

Custom properties in the Central Desigher application

| Properties 7 =
e
B lem B Clintrial
(=1 Clintrial Derived
SAS Mame Mandabary
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Thesauns
Deiived S5 Mafme
. Thesaurus
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1 2

1—A portion of the Custom Properties workspace in the Central Designer Administrator
application.

2—A portion of the Properties Browser in the Central Designer application. Custom properties
defined under the Clintrial grouping appear in the Central Designer application under the same
Clintrial grouping, and custom properties defined under the InForm grouping appear in the Central
Designer application under the same InForm grouping.

72 Oracle® Health Sciences Central Designer 2.1



Administrator Guide

Custom Properties workspace—Field descriptions

The fields that appear in the Custom Properties workspace vary according to what you select. You
can select a study object, a grouping, or a custom property.

Field Description

A study object is
selected.
Groupings Name of the grouping for the study object.
Groupings organize custom properties in the Central Designer application.
A grouping is
selected.

Custom Properties Name of the custom property created under the grouping for a study

object.
A custom property
is selected.
Name Name of the custom property.
Data Type Data type of the custom property:

¢ Text—Contains alphanumeric characters.
e Integer—Contains only numbers.
e Boolean—True or False.

e Float—Contains numbers and a decimal point.

Max Length Maximum number of characters allowed for the value of the custom
property.

Description Description of the custom property.

Make Property e Selected—Users can see this property in the Properties Browser in the

Visible Central Designer application.

e Not Selected—The property is not visible in the Properties Browser in
the Central Designer application.
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Field Description

Use Value List e Selected—Central Designer users must select a value for the custom
property from a list of possible values. You can define these values in
the grid with the Value and Default fields.

e Not selected—Central Designer users must supply a value for the
custom property.

The Use Value List grid has the following fields.

e Value—A value for the custom property. All values are available in a
drop-down list in the Central Designer application. If Use Value List is
selected, Central Designer users must select a value for the custom

property.
¢ Default—When selected, the value is selected by default for the

custom property in the Central Designer application. You can select the
checkbox for only one value.
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Working with report definitions

Exporting the file for report definitions

If you have modified the XML definition file for reports, you must export it before you upgrade.

1
2

Select System Config.

Under Customization, select Reports Definitions.
The Reports Definitions workspace appears.
Click Save As.

The Save As dialog box appears.

Provide a name for the file, browse to the location in which to save it, and click Save.

Note: After a Central Designer upgrade, you must re-import the report definitions. For more
information, see Updating report definitions (on page 75). For information about developing and
importing new custom reports, contact Oracle Services.

Updating report definitions

On each Central Designer application server:

1

Copy the updated custom reports definition file to the following location, overwriting the
existing file:

<designer_root>\
DBSchema\_Last\Datainstaller\DesignerReportsDefinitions.xml

where <designer_root> is the root directory of the Central Designer installation.
From the <designer_root>\bin directory, run the UpdateReports.bat file.

The UpdateReports.bat file updates the definitions of the custom reports in the database.

Reports Definitions workspace

In the Reports Definitions workspace, you can export the currently defined reports definitions.

To open the Reports Definitions workspace:

1
2

Click the System Config button.

Under Customization, click Reports Definitions.
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Working with units definitions

Exporting and importing a units file

If you have modified the units file, you should export it before you upgrade and then import it after
you upgrade. To add new units, you can export the file, modify it, and import it at any time.

To import a units file:
1 Select System Config.
2 Under Customization, select Unit Definitions.
The Unit Definitions workspace appears.
3 Click Import.
The Open dialog box appears.
4 Navigate to the location of the units file, and select it.
5  Click Open.
To export the units file that is in the database:
1 Select System Config.
2 Under Customization, select Unit Definitions.
The Unit Definitions workspace appears.
3 Click Save As.
The Save As dialog box appears.
4 Provide a name for the file, browse to the location in which to save it, and click Save.

The file is saved.

Units Definitions workspace

In the Units Definitions workspace, you export the currently defined units definitions, modify the file
outside of the application, and then import the modified file. You cannot modify a file that has
already been imported.

Units information is used by all application servers in a web farm and is stored in the database.
To open the Units Definitions workspace:

1  Click the System Config button.

2 Under Customization, click Unit Definitions.
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Working with coding information

Importing and overwriting a dictionary type

You can import dictionary types at any time. An imported dictionary type is enabled by default.

You cannot remove a dictionary type after importing it. If you want to update a dictionary type, you
can either:

Modify or rename the file and then import a new file.
Overwrite the existing dictionary type.

If the original dictionary type is used by one or more coding maps and updates to the dictionary
type change its structure (for example, if coding levels are added or removed), you receive a
message that indicates that the import cannot be done because the coding maps would be made
invalid.

To import or overwrite a dictionary type:

1
2

Select System Config.

In the Coding section, click the Dictionary Types link.

The Coding Dictionaries workspace appears.

Click Import.

The Open dialog box appears.

Navigate to the location of the dictionary type file, select it, and click Open.

If you are overwriting a dictionary type, a dialog box appears. Review and confirm the changes.

The import might take a few moments. After the import is complete, you receive a message that
the import is finished.

An imported dictionary type is enabled by default. If you do not want the dictionary type to be
available for creating coding maps, you can disable it.

Enabling and disabling a dictionary type

A dictionary type must be in the Central Designer Administrator application before you can enable it.

To make a dictionary type available to be added to a study or library, you must enable it. When a
dictionary type is disabled, it cannot be added to any studies or libraries.

If you disable a dictionary type that is used by a study or library in the Central Designer application,
Central Designer users can view its coding maps but cannot create or modify them.

To enable a dictionary type:

1
2

Select System Config.
In the Coding section, click the Dictionary Types link.
The Coding Dictionaries workspace appears.

Select the Enabled checkbox for the dictionary.
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4 Click Save.

To disable a dictionary type:

1  Select System Config.

2 In the Coding section, click the Dictionary Types link.
The Coding Dictionaries workspace appears.

3 Desclect the Enabled checkbox for the dictionary.

4 Click Save.

Renaming a dictionary type

If you rename a dictionary type, the coding maps that were created for the dictionary type are still
valid.

1 Select System Config.
2 In the Coding section, click the Dictionary Types link.
The Coding Dictionaries workspace appears.
3 Click within a Type field for a dictionary type.
The text becomes editable.
4 Type a new name for the dictionary type, and press Enter.

5 Click Save.

Adding, modifying, and deleting a verbatim type
1 Select System Config.
2 In the Coding section, click the Verbatim Types link.

The Verbatim Types workspace appears. It displays information about existing verbatim types,
followed by a blank row.

3 Do one of the following:
¢ To add a verbatim type: Type the name and description in the blank row.

¢ To modify a verbatim type: Double-click the text that you want to modify, and type the
correct text. Click Save.

e To delete a verbatim type: Right-click the verbatim type, and select Delete Row.

Note: You cannot delete a verbatim type that is in use.
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Importing and overwriting dictionary metadata

If a dictionary metadata update is implemented in the Central Coding application, you will need to
update dictionary metadata items in the Central Designer application. Oracle will provide you with an
XML file that you must import to continue using and creating coding maps in the Central Designer
application.

Note: Do not import an XML file unless specifically directed by Oracle, or your coding maps will
become invalid.

1 Select System Config.
2 In the Coding section, click the Dictionary Metadata link.
The Coding Dictionaries Metadata workspace appears.
3 Click Import.
The Open dialog box appears.
4 Navigate to the location of the dictionary metadata XML file, select it, and click Open.

If existing coding maps reference a dictionary metadata item that will be removed as a result of
the import, a dialog box appears to alert you of the changes.

If no dictionary metadata items will be removed as a result of the import, or if the dictionary
metadata items that will be removed are not used, the import begins immediately.

The import might take a few moments. After the import is complete, you receive a message that
the import is finished.

Dictionary Types workspace

In the Dictionary Types workspace, you import and enable dictionary types. You also can overwrite
dictionary types. A dictionary type is a name or identifier for the metadata for a dictionary.

About dictionary types

Characteristic Description

Definition and A dictionary type is a name or identifier for the metadata for a dictionary.
purpose You create a coding map for a verbatim using a dictionary type.

The dictionary type specifies the metadata for all versions of a dictionary,
including:

e Verbatim types.
e Dictionary levels.
e Dictionary level types, such as Term or Code.

e Where applicable, context meanings.
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Characteristic Description

Dictionary types in  The following dictionary types are installed with the Central Designer
the installation application:

e MedDRA—Medical Dictionary for Drug Regulatory Activities.
e MedDRAJ—]apanese version of the MedDRA dictionary.

e WHO-DD—World Health Organization Drug Dictionary (formetly
WHO-DRL—World Health Organization Drug Reference List).

¢ JDrug—]Japanese drug dictionary.

Importing You can import other standard dictionary types as well as custom dictionary
types in the Central Designer Administrator application.

For more information, see Importing and overwtiting a dictionary type
(on page 77).

Multiple versions The Central Designer application supports multiple versions of a dictionary

type.

A version consists of dictionary metadata and dictionary data. In most
cases, versions are different only in data, but new versions can also contain
new metadata.

Using in a study or  To use a coding dictionary in a study or library to create coding maps, you
library must use the following process:

1 Import the dictionary type (on page 77).
2 Enable the dictionaty type (on page 77).
3 Select the dictionary type for a study or Library (in the InForm Design

Guide).
Association with You can associate multiple verbatim types with a single dictionary type.
verbatim types
Deployment Dictionary types that are used in the coding maps are deployed to the

InForm application as MedML DICTIONARY objects.

To open the Dictionary Types workspace:

1 Click the System Config button.
2 Under Coding, click Dictionary Types.

For more information, see Dictionary Types workspace - Field descriptions (on page 82)
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Verbatim Types workspace

In the Verbatim Types workspace, you create and edit verbatim types. A verbatim type is a
classification of a verbatim as defined in a coding dictionary.

Note: You associate verbatim types with dictionary types in the Study Editor in the Central
Designer application.

About verbatim types

Characteristic Description

Definition and A verbatim type is a classification of a verbatim as defined in a coding
purpose dictionary.

Verbatim types in the e AE—Adverse Event

nstallation « DISEASEDisease
e LABDATA—I.ab data
¢ MEDPROD—Medical product
Association with You can associate multiple verbatim types with a single dictionary type.

dictionary types

To open the Verbatim Types workspace:

1  Click the System Config button.

2 Under Coding, click Verbatim Types.

Coding Dictionary Metadata workspace

In the Coding Dictionary Metadata workspace, you view existing dictionary metadata items and
import new dictionary metadata items to overwrite the existing dictionary metadata items. A
dictionary metadata item is an identifier that describes administrative data about a dictionary and that
you can use to create a coding map.

To open the Coding Dictionary Metadata workspace:
1  Click the System Config button.
2 Under Coding, click Dictionary Metadata.

For more information, see Coding Dictionary Metadata workspace - Option descriptions (on
page 82).
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Dictionary Types workspace—Field descriptions

Field Description

Type Name of the dictionary type.

Note: In the dictionary type XML file, this information comes from the
DictionaryType type field. You can modify this information by double-
clicking the Type field.

Description Description of the dictionary type.

Note: In the dictionary type XML file, this information comes from the
Description field. You can modify this information by double-clicking the

Description field.

Import date Date on which the dictionary type was imported.

Enabled Indicates whether the dictionary type is enabled. Only enabled dictionary
types can be used to create coding definitions in the Central Designer
application.

Coding Dictionary Metadata workspace—Option descriptions

Field Description

Display Name Name of the dictionary metadata item; either Dictionary or CoderName.
Version Version number for the dictionary metadata item.
Level Dictionary level for which a coding map can be defined for the metadata item;

either Dictionary or CoderName.

Level Type Information that indicates the type of supported target item for the dictionary
metadata item. The only available option is Term.

Description Description of the dictionary metadata item; either Dictionary or CoderName.
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Working with security settings

Changing the security settings for accounts and sessions
1  Select System Config.
2 Under Security, select Settings.
3 Modity the settings as needed.
For more information, see:
e  Security settings workspace (on page 83).

e Security settings workspace—Option descriptions (on page 83).

Security Settings workspace

In the Security Settings workspace, you view and modify the security settings for user accounts and
logon sessions. For more information, see Changing the security settings for accounts and
sessions (on page 83).

To open the Security Settings workspace:

1  Click the System Config button.
2 Under Security, click Settings.

For more information, see Security Settings workspace - Option descriptions (on page 83).

Security Settings workspace—Option descriptions

Description Default value |Acceptable
range

Passwords
section
Passwords expire ~ When selected, passwords expire after 30 days 1 day - 365 days
every the specified number of days.

Otherwise, passwords do not expire.
Enforce password When selected, you can specify the 4 4-12 passwords
history number of recently used passwords that

cannot be reused.

For example, if you specify 4 in the

Enforce password history ficld, when

changing a password, users cannot use

any of their four previously used

passwords.
Minimum Minimum required length of a password 8 characters 6 - 20 characters

password length  for any user.
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Description Default value

Acceptable
range

Number of
password re-tries

Number of failed logon attempts that 3 attempts
are allowed before a uset's account is

locked. A user with a locked account

cannot log on for 30 minutes.

1-10 attempts

Password
complexity

Low—The password must meet the High
length requirement.

Medium, High, or Very High—The
password must meet the length
requirement and meet one (for
Medium), two (for High), or all (for
Very High) of the following
requirements:

o At least one letter and one number.

e At least one non-alphanumeric
character.

e At least one upper-case and one
lower-case letter.

Not applicable.

Account lockout
section

Lockout System
account for

Amount of time the system user account 30
is locked out of the Central Designer
application after exceeding the allowed
number of login attempts.

0 minutes - 23
hours, 59 minutes

Lockout user for

Amount of time a user account is locked 30
out of the Central Designer application

after exceeding the allowed number of

login attempts.

0 minutes - 23
hours, 59 minutes

Manually reactivate
user

When selected, the user is locked out of Not selected
the Central Designer application after

exceeding the allowed number of login

attempts, and cannot log back in until an

administrator reactivates the user

account.

Note: This option takes precedence
over the Lockout user for field setting.

Not applicable.
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Description Default value |Acceptable

range

Session settings

section
Inactivity timeout ~Amount of time in which users can stop 20 minutes 15 minutes - 23
working before they are prompted to re- hours, 59 minutes
enter their passwords.
Note: The Inactivity timeout value must
be lower than the User must re-
authenticate value.
User must re- The amount of time that can pass before 4 hours 1 hour - 6 days,
authenticate every users are prompted to re-enter their 23 hours, 59
passwords, even if they have not minutes
stopped working.
Study visibility
section
Restrict study When selected, studies and libraries are  Selected for new Not applicable.
visibility to study  hidden from the users who are not installations.
team members members of the study teams and libra .
Y ™Y Not selected if
teams.
you upgraded
Note: Studies and libraries are always from Central
visible to the users who create them. Designer release

2.0 or earlier.
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Working with deployment options

Deployment Server Types workspace

In the Deployment Server Types workspace, you configure the default automated deployment
options for each type of InForm server. The settings apply to all studies, and you can configure
whether to allow users to override the settings from the Central Designer client application.

To configure the default deployment options:
1  Select System Configuration.
2 In the Deployment section, click the Server Types link.
3 Modity the settings as needed for each server type:
e  UAT—User acceptance testing
¢ QA—Quality assurance
e DEV—Development
e LIVE—Production
e TRN—Training

For more information, see Deployment Server Types workspace—Option descriptions (on page
87).
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Reason Text workspace

In the Reason Text workspace, you define the reasons that Central Designer users select when they
perform automated deployment operations. Default reason texts are available for all deployment
operations, and you can add, modify, and delete texts. Reason texts cannot be edited by users in the
Central Designer application.

Each row in the table in the Reason Text workspace displays a reason text for a deployment
operation. Multiple reasons can be defined for each deployment operation.

To add, modify, or remove deployment reasons:

1  Select System Configuration.

2 In the Deployment section, click the Reason Text link.
The Reason Text workspace appears.

3 Do one of the following:

e To add a reason text for a deployment operation: In the blank row, select an operation
from the drop-down list in the Deployment Operation column, and then enter the reason
text in the Reason Text column.

¢ To modify a reason text for a deployment operation: Edit the text in the Reason Text
column for the deployment operation.

e To delete a reason text for a deployment operation: Right-click a row, and select Delete
Row.

Note: The reason text must not contain any PHI.

Deployment Server Types workspace—Option descriptions

The following table describes the default deployment options for each type of InForm server, and
indicates whether overriding in the Central Designer client application is allowed by default.

Description Default Client override
value default
Approvals When selected, deployment requests for the Not selected — Allowed
Required type of instance require approval. for DEV and
QA.
Selected for
LIVE, TRN,
UAT.
Deployment Start ~ Time to wait (in milliseconds) for the 0 Allowed
Delay InForm caches to initialize.
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Deployment Reason Text workspace—Option descriptions

Description

Deployment Select an automated deployment operation for which to set the reason text:

Operation .

Request Deployment—Create a deployment request.
Approve Deployment—Approve a deployment request.
Reject Deployment—Reject a deployment request.

Cancel Request—Cancel a deployment request that has not been
approved yet.

Cancel Deployment—Cancel a deployment that has been approved, but
has not started yet.

Reason Text Enter the reason text.
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Checklist—Creating and using keywords and categories

Use the following checklist to set up the Study Objects and Users catalogs in the Central Designer
Administrator application. Catalogs consist of keywords and categories.

Perform the steps in the order in which they are presented. Depending on how your company uses
the Central Designer application, you might not need to perform all steps.

For more information about the catalog wotkflow, see Workflow for categorizing users with
categories and keywords (on page 94).

M Workflow step Where to get more information

a1

Choose the catalog (Study Objects or Users)
to which you are adding keywords or
categories.

About the catalog workspace (on page
95).

Create one or more keywords.

Creating and deleting a keyword (on
page 91).

Create one or more categories.

Creating and removing a category (on
page 92).

Categorize users with keywords and
categories.

Categorizing a user with keywords and
categories (on page 25).

Categorize study objects with keywords and
categories.

User Guide

920
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Working with a catalog

Searching a catalog for a keyword

You can search for keywords in the Study Objects catalog and Users catalog.

Note: The search in both catalogs is case sensitive. For example, if you type Designer in the
search field, the search engine does not detect the designer keyword.

Click the Catalog button.

In the Catalog section, click one of the following links:

¢ Study Objects—The Study Objects Catalog workspace appears.
e Users—The Users Catalog workspace appears.

In the Click here to search or create a new Keyword field, type a keyword.

As you type, a real-time search of the list is performed, and the first keyword that matches the
text that you type is selected.

Note: If you type a keyword that is not in the list, and you want to add it to the list, press
Enter.

Creating and deleting a keyword

Keyword names must be unique. Keywords are also case sensitive—for example, radiotherapy and
Radiotherapy are considered unique keywords.

Note: If you delete a keyword that is used to categorize a study object or user, the study object
and user are no longer searchable by the keyword.

Note: You cannot modify or delete a user keyword.

To create a keyword in a catalog:

1
2

Click the Catalog button.

In the Catalog section, click one of the following links:

e Study Objects—The Study Objects Catalog workspace appears.

e Users—The Users Catalog workspace appears.

In the Click here to search or create a new Keyword field, type a keyword, and press Enter.

or

Right-click the Keywords list, and select Add, or press Ctrl+N. In the dialog box that appears, type a

keyword, and press Enter.

The keyword is added to the list for the selected catalog.
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To delete a keyword:

1  Click the Catalog button.

2 In the Catalog section, click one of the following links:
¢ Study Objects—The Study Objects Catalog workspace appears.
e Users—The Users Catalog workspace appears.

3 In the Keywords list, select a keyword, and press Delete.
or

In the Keywords list, right-click a keyword, and select Delete.

Copying a keyword

You can copy a keyword and then paste it to the Categories tree.

Note: When you paste a keyword to the Categories tree, it exists in the Keywords list as a keyword
and the Categories tree as a category. When you select the keyword in the Keywords list, all
instances of the keyword in the Categories tree are highlighted in bold text.

1  Click the Catalog button.

2 In the Catalog section, click one of the following links:
e Study Objects—The Study Objects Catalog workspace appears.
e Users—The Users Catalog workspace appears.

3 In the Keywords list, right-click the keyword that you want to copy, and select Copy.

4 In the Categories tree, right-click the category in which you want to create the category, and select

Paste.

Creating and removing a category

92

You create new categories by dragging keywords to the Categories tree. You can also create
categories by copying keywords and pasting them in the Categories tree. You can remove a category
from the Categories tree at any time.

Note: If you delete a category that is used to categorize a study object or user, the category and
all child categories below it are deleted. Study objects and users are no longer searchable by the
deleted categories.
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To create a category:
1  Click the Catalog button.
2 In the Catalog section, click one of the following links:
e Study Objects—The Study Objects Catalog workspace appears.
e Users—The Users Catalog workspace appears.
3 In the Keywords list, select a keyword and drag it to the desired location in the Categories tree.

e To add the keyword below a specific category in the Categories tree, drag the keyword to that
category.

e To add the keyword to the highest level of the Categories tree, drag the keyword to blank
space in the Categories section.

or

In the Keywords list, right-click a keyword, and select Copy. In the Categories tree, right-click a
category, and select Paste.

To remove a category:

1  Click the Catalog button.

2 In the Catalog section, click one of the following links:
e Study Objects—The Study Objects Catalog workspace appears.
e Users—The Users Catalog workspace appears.

3 In the Categories section, right-click the category that you want to remove, and select Remove, or
press Delete.

Cutting, copying, or pasting a category

You can cut, copy, and paste categories that appear in the Categories tree in the Study Objects and
Users catalogs.

Note: When you cut and copy a category, you also cut or copy all child categories below it.

1  Click the Catalog button.
2 In the Catalog section, click one of the following links:
¢ Study Objects—The Study Objects Catalog workspace appears.
e Users—The Users Catalog workspace appears.
3 In the Categories tree, right-click a category, and select one of the following options:
e Copy (or press Ctrl+C)—Create a copy of the category and all child categories below it.
e  Cut (or press Ctrl+X)—Cut the category and all child categories below it.

4 Right-click the category below which you want to paste the cut or copied category, and select
Paste, or press Ctri+V.
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Workflow for categorizing users with categories and keywords

94

An administrator for the Central Designer Administrator application follows these steps to categorize
Central Designer users:

1 The administrator selects a user and selects the Categorization tab, where you can view all
keywords and categories in the Users catalog.

2 The administrator categorizes users with one or more keywords and categories.

A Central Designer study administrator follows these steps to search for categorized users:

1 The study administrator opens the Users Browser and searches using categories and keywords as
search parameters.

The search finds only users categorized with the selected parameters.
2 The study administrator adds the users to study or library teams.

In the following example, assume a user is a study architect with .NET experience working in
Boston. That user could be categorized with the INET, Architect, and Boston keywords. If Central
Designer users select the NET, Architect, or Boston (or all three) keywords as search parameters,
then the user appears in the search results.

Azzociate with keywiords.

MET
Architect
Eostan
[ D ata Specializt
[ Designer
O Developer
[ Dublin

O Gereva
[ Location
O London
O rsss0L
[ skills

O vE Script
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About the Catalog workspace

In the Catalog workspace, you perform catalog administration using keywords and categories.
Keywords and categories are used to categorize:

e  Users in the Central Designer Administrator application.
e  Study objects in the Central Designer application.

Categorizing users and study objects with keywords and categories allows for faster and more
efficient searching in the Users Browser and Libraries Browser in the Central Designer application.

e A keyword is an identifier that is associated with users and study objects to facilitate more
powerful and efficient searches. A keyword can be system-generated or user-defined. Keywords
appear in the Keywords list.

e A category is a hierarchical grouping of keywords. You can create categories only from existing
keywords. A category can be automatically generated or manually generated. Categories appear in
the Categories tree.

The Catalog workspace contains two catalogs:
e Study Objects catalog—Create keywords and categories for study objects.

e Users catalog—Use system keywords to create categories for users.

Types of keywords and categories

The Study Objects and Users catalogs contain system and user keywords and automatically generated
and manually generated categories. The following table describes each keyword and category and tells
the location of each in the Central Designer application.

Type of keyword or category Location in Location in
Libraries Browser Users Browser

System keywords Keywords tab > Keywords tab >
System list System list

System keywords are keywords that are installed by default
with the Central Designer application or that an
administrator creates in the Central Designer
Administrator application.

User keywords Keywords tab > You cannot

. User list categotize users
User keywords are keywords that a Central Designer user &

. with user

creates. You cannot view keywords that other users create,
. keywords.
and other users cannot view your user keywords. Only
study objects can be categorized with user keywords.
Automatically generated categories Categories tab > Categories tab >
. . . Automatically Automatically
Automatically generated categories are categories that
Generated tree Generated tree

automatically catalog study objects by auditing information
(for example, the study object type, original author,
creation date, and library in which the study object was
created).
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Type of keyword or category Location in Location in
Libraries Browser Users Browser

Manually generated categories Categories tab > Categories tab >
Manually Manually

Manually generated categories are categories that you

) . Generated tree Generated tree
create by dragging keywords to the Categories tree.

Note: The Libraries Browser and Users Browser are in the Central Designer application.
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Working with event log messages for a web farm

Working with Event Log messages for a web farm

98

To view the messages:

1
2

8

Select Server Management.

Under Server Management, select Event Log Messages.
The Event Log Messages workspace appears.

Click Export.

A dialog box appears.

Select a start date and time and an end date and time.
Click Browse.

The Save As dialog box appears.

Type a file name, browse to a location, and click Save.
Click OK.

After the file is created, a message informs you of the number of messages that it contains.

Open and review the file.

To change the default limit for the number of entries in the log:

Note: Changing the default limit for the number of entries in the log does not affect the Event Log
on the application server. This limit applies only to the information that has been collected from
all of the application servers and saved in the database.

1
2

3

Select Server Management.
Under Server Management, select Event Log Messages.
The Event Log Messages workspace appears.

In Maximum Rows in Database, type the number to use as the limit.

To delete all entries in the log:

1
2

[SM)

Select Server Management.

Under Server Management, select Event Log Messages.
The Event Log Messages workspace appears.

Click Purge.

A dialog box appears.

Choose one of the following options:

e To delete all messages, select Purge All.

e To delete all messages before a specific date, select the date from the Before Date drop-down
list.
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Event Log Messages workspace

If your environment supports a web farm, you work with entries from the Event Log in the Event
Log Messages workspace.

Each application server in the web farm contains a separate Event Log. However, all information,
warning, and error messages that are related to the Central Designer application are collected in a
table in the database. The table contains one row for each entry in the Event Log.

You can request the messages for a range of dates. An XML file that contains log information is
created. You can analyze the XML file using an application that views XML information, or you can
use an XSLT transfer to read the file in the Microsoft Internet Explorer browser.

The limit for the number of entries in the log is 10,000 by default, but you can configure the number.
An Oracle database job runs nightly to delete older records that exceed the limit for the number of
entries. The next Oracle database job that runs uses the setting that you provide. Additionally, at any
time you can delete all entries in the log or entries that were logged before a specified date.

To open the Event Log Messages workspace:

1  Select Server Management.

2 Under Server Management, click Event Log Messages.
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Working with a web farm and the primary job scheduler

Determining and changing the primary job scheduler

Only one computer can run the job scheduler service at any time.
To determine the primary job scheduler:

1  Select Server Management.
2 Under Server Management, select Job Scheduler.
The Job Scheduler workspace appears.
The primary job scheduler appears in the Machine name drop-down list.

To change the primary job scheduler:

1  Select Server Management.
2 Under Server Management, select Job Scheduler.
The Job Scheduler workspace appears.

3 In the Primary Job Scheduler section, Machine name drop-down list, select the computer on which
to run the Job Scheduler service. If the name of a server in the web farm does not appear (for
example, if you renamed it), click Other, and type the name of the computer.

Note: If you rename a computer after installing the Central Designer server application on
it, the name of the computer no longer appears in the drop-down list. If you remove a server
from the web farm, its name still appears in the list.

4 Click Save.

After the Job Scheduler service that was the primary finishes processing the requests that were in
its queue, it becomes idle. The new primary job scheduler processes all new requests.

Viewing the servers that are in the web farm

1  Select Server Management.
2 Under Server Management, select Job Scheduler.
The Job Scheduler workspace appears.

The Machine name drop-down list includes all servers in the web farm.

Note: If you rename a computer after installing the Central Designer server application on
it, the name of the computer no longer appears in the drop-down list. If you remove a server
from the web farm, its name still appears in the list.
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Removing a server from a web farm
To remove the setver with the primary Job Scheduler from a web farm:

1 Change the primary Job Scheduler (on page 100).

2 Wait until the Job Scheduler service becomes idle, indicating that it is finished processing
requests.

3 Follow your organization's regular procedure for removing a server from a web farm.

To remove a server that does not have the primary Job Scheduler:

e Follow your organization's regular procedure for removing a server from a web farm.

Checking whether the primary Job Scheduler service is running

1  Select Server Management.
2 Under Server Management, select Job Scheduler.
The Job Scheduler workspace appears.

A graphic with text appears to the right of the Machine names drop-down list, indicating whether
the service is running,.
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Viewing job properties and cancelling a job in the Job Scheduler queue

Examples of jobs include validation and file import as well as scheduled jobs.

Note: You cannot cancel a scheduled job.

Click the Server Management button.

Under Server Management, click Job Scheduler.

The Job Scheduler Manager workspace appears.

All jobs appear in the grid.

If a job does not appear in the grid, in the toolbar above the grid, click Refresh.

To view details about a job:

a

b

In the grid, select the job.

In the toolbar above the grid, click Properties.

To cancel a job:

a

b

C

In the grid, select one or more unscheduled jobs.

Note: The job name in the Job Scheduler workspace corresponds to the job name in
the Jobs Browser. Use the job nhame to identify a specific job to stop in the Central
Desigher Administrator application.

In the toolbar above the grid, select Stop Job.
You are prompted to confirm.

Click Yes or, if you selected multiple jobs, Yes to All.

Job Scheduler workspace

102

In the Job Scheduler workspace, you perform the following tasks:

Check whether an instance of the Job Scheduler service is running,

View and cancel jobs in the job scheduler queue.

Determine and change the primary job scheduler.

View job properties.

Configure the polling interval for retrieving the status of deployment.

To open the Job Scheduler workspace:

1

Click the Server Management button.

2 Under Server Management, click Job Scheduler.
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Setting the polling interval for retrieving the status of deployment

The UpdateDeploymentStatuses job retrieves the status of deployments and the deployment logs
from the InForm application.

1  Click the Server Management button.
2 Under Server Management, click Job Scheduler.
The Job Scheduler workspace appears.

3 In the Poll every drop-down list, select the polling interval (in minutes). The default is 10 minutes.
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Keyboard shortcuts

Keyboard shortcuts for opening menus

The following shortcuts are always available.

Alt+F Open the File menu.
Alt+E Open the Edit menu.
Alt+V Open the View menu.
Alt+A Open the Actions menu.
Alt+H Open the Help menu.

Keyboard shortcuts for the Users workspace

106

The following shortcuts are available when the Users workspace appears.

Ctrl+D Deactivate the selected user.

Ctrl+N Create a new uset.

Ctrl+T Terminate the selected user.

Ctrl+E Activate the selected user.

Ctrl+P Change the password of the selected user.

Ctrl+C Copy the selected user.

Personal Info tab The following shortcuts are available only when the Personal Info

tab is selected.

Alt+T Select the Title field.

Alt+N Select the Position field.
Alt+S Select the First Name field.
Alt+L Select the Last Name field.
Alt+M Select the Email field.

Alt+C Select the Company field.
Alt+R Select the Department field.
Alt+D Select the Address field.
Alt+] Select the City field.

Alt+P Select the Postal Code field.
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Alt+V Select the State/Province field.
Alt+U Select the Country field.

Alt+0 Select the Telephone field.
Alt+B Select the Mobile field.

Alt+X Select the Fax field.

Alt+G Select the Pager field.

Keyboard shortcuts for the Roles workspace

The following shortcuts are available when the Roles workspace appears.

Ctri+N Create a new role.
Ctrl+C Copy the selected role.
Delete Delete the selected role.

Keyboard shortcuts for the Custom Properties workspace

The following shortcuts are available when the System Config workspace appears and the Custom
Properties link is selected.

Keyboard shortcut Description

Delete Remove the selected custom property.

Ctrl+N e If a study object is selected—Create a new grouping,.

e If a grouping is selected—Create a new custom property.

Ctrl+R e If a grouping is selected—Rename the selected grouping,.

e Ifa custom property is selected—Rename the selected custom
property.

Ctrl+C e If a grouping is selected—Copy the selected grouping.

e If a custom property is selected—Copy the selected custom property.

Ctrl+X e If a grouping is selected—Cut the selected grouping.

e If a custom property is selected—Caut the selected custom property.

Ctrl+V e If a grouping is selected—TPaste the selected grouping.

e If a custom property is selected—Paste the selected custom property.
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Keyboard shortcuts for the Catalog workspace

The following shortcuts are available when the Catalog workspace is visible.

Keyboard shortcut Description

Ctrl+N Create a new keyword.
Delete Delete the selected keyword or category.
Ctrl+C e If a keyword is selected—Copy the selected keyword.

e If a category is selected—Copy the selected category.

Ctrl+V Paste the selected category.

Ctrl+X Cut the selected category.
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Status toolbar—Option descriptions

Option Description

& You are logged on, and the application is connected to the application setver.
s & e (Gray circle icon)—The server is not processing information, and you can
ot
work.

e (Blue circle icon)—The server is processing information. Wait until the
process completes before performing another activity.
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Roles workspace—Right descriptions

When you create a role, you choose the scope of the role. A role can have a library, study, or
application scope. Each scope has a set of rights that you can grant to the role.

e Roles with the library scope become library teams in the Central Designer application.
e Roles with the study scope become study teams in the Central Designer application.

Users are granted rights associated with roles in the following manner:

e Application roles

A user assigned to an application role is granted all of the rights that are associated with the role,
without restrictions. For example, a user who has the right to create users can always create
users.

For more information, see Application roles—Right descriptions (on page 113).
e Library roles

A user assigned to a library role is granted the rights associated with the role only in libraries
where that user is also a member of the library team. For example, if a user is assigned to the
Librarian library role in the Central Designer Administrator application, the user must be a
member of the Librarian library team for a library (in the Central Designer application) to work
in the library.

For more information, see Library roles—Right desctiptions (on page 120).
e  Study roles

A user assigned to a study role is granted the rights associated with the role only in studies where
the user is also a member of the study team. For example, if a user is assigned to the Rule
Creation study role in the Central Designer Administrator application, the user must also be a
member of the Rule Creation study team for a study to create rules in the study.

For more information, see Study roles—Right descriptions (on page 123).

Note: You assign users to roles in the Central Designer Administrator application and to study and
library teams in the Central Designer application.
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Application roles—Right descriptions

The rights for application roles are related to activities in the Central Designer and Central Designer
Administrator applications. Users do not need to be assigned to any teams to have rights.

Application Administration

Right Permissions

Log on to the Central Log on to the Central Designer application.

Designer software

Log on to the Central Log on to the Central Designer Administrator application.
Designer Administrator

software

Perform all activities in all e Log on to the Central Designer and Central Designer
studies and libraries (super- Administrator applications.

user)

e Use all functionality in the Central Designer and Central
Designer Administrator applications, regardless of team
assignment.

e Perform other administrative tasks, such as close a task opened
by someone else and unlock the locks held by other users.

Archive Administration

Import archive Import an archived study, study project, or library project.
Archive library project Archive a library project.

Archive studies and study Archive a study or study project.

projects

Catalog Administration

Right Permissions

Create keywords and categories in  Create keywords and categories in the Users catalog.
Users Catalog

View Users catalog View the Users catalog.

Delete keywords and categories in  Delete keywords and categories in the Users catalog.
Users catalog
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Right Permissions

Create keywords and categories in  Create keywords and categories in the Study Objects catalog.
Study Objects catalog

View Study Objects catalog View the Study Objects catalog,.

Delete keywords and categories in - Delete keywords and categories in the Study Objects catalog.
Study Objects catalog

Note: These rights provide access to functionality in the Central Desigher Administrator
application.

Coding Dictionaries Administration

Right Permissions

Create and modify coding Create and modify coding dictionary types.
dictionary types

View coding dictionary types ~ View coding dictionary types.

View and modify coding View and modify coding dictionary metadata items.
dictionary metadata items

Note: These rights provide access to functionality in the Central Designer Administrator
application.

Collaboration Administration

114

Right Permissions

Create and modity Create and modity collaboration note types.
collaboration note types

View collaboration note types  View information about collaboration note types.

Delete collaboration note Delete collaboration note types.
types

Create and modify task types ~ Create and modify task types.
View task types View information about task types.
Delete task types Delete task types.

Note: These rights provide access to functionality in the Central Designer Administrator
application.
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Custom Properties Administration

Right Permissions

Create and modify custom  Create and modify custom properties and groupings.
properties

View custom properties View information about custom properties.

Delete custom properties  Delete custom properties and groupings.

Note: These rights provide access to functionality in the Central Designer Administrator
application.

Deployment Administration

Right Permissions

Modify deployment settings ~ Modify deployment settings.

View approvals across studies  View approvals from all studies, including studies on which the
user is not a study team member.

In-place Revisions Administration

Right Permissions

Modify IPR Settings Modify the settings in the In-place Revisions workspace, which is
available under System Configuration.

View IPR Settings View the In-place Revisions workspace.

Language Library Administration

Right Permissions
Modify language library Reserved for future use.
View language library Reserved for future use.
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Library Administration

Administer library teams Create, modify, and delete library teams.
Create Libraries Create library projects and libraries.
Modify library properties e  Enable and disable libraries.

e Modify library projects and libraries.

e Modify library properties in the Library Editor >
Administration tab and the Properties Browser.

Delete libraries Delete a library project and all of its study objects.

Locales Administration

Add locales Add locales.
View locales View information about locales.
Remove locale Remove locales.

Note: These rights provide access to functionality in the Central Designer Administrator
application.

Reports Administration

Right Permissions

Modify the list of available Import a new reports file into the database.
reports in the system

Note: These rights provide access to functionality in the Central Designer Administrator
application.
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Role Administration

Search

Right Permissions

Create and modify roles Create and modify roles in the Central Designer Administrator
application.

View roles View information about roles in the Central Designer

Administrator application.

Delete roles Delete roles in the Central Designer Administrator application.

Change users in roles Assign users to roles.

Note: These rights provide access to functionality in the Central Desigher Administrator
application.

Right Permissions

Search for users Search for users in the Users Browset.

Save and modify user searches  Save and modify Users Browser searches.

Delete user searches Delete Users Browser searches.

Search for study objects Search for study objects in the Libraries Browser.

Save and modify study object  Save and modify Libraries Browser searches.
searches

Delete study object searches Delete Libraries Browser searches.

Security Settings Administration

Right Permissions

View security settings View the Security workspace, which is available in the System
Contfig view.

Modify security settings Modify the options in the Security workspace.

Note: These rights provide access to functionality in the Central Designer Administrator
application.

Oracle® Health Sciences Central Designer 2.1 117



Appendix A Rights descriptions

Sponsors Administration

Right Permissions

Create and modify sponsors Create and modify sponsors in the Sponsors workspace in the
Central Designer Administrator application.

Remove sponsors Delete sponsors from the Sponsors workspace in the Central
Designer Administrator application.

View sponsors View the list of sponsors in the Sponsors workspace in the Central
Designer Administrator application.

Study Administration

Administer study teams Create, modify, and delete study teams.
Create studies Create study projects and studies.
Create study project e Mark study projects as templates.
templates

e View study project templates in the Open Project dialog box.

Delete studies Delete a study or study project and all of its study objects.

Modify deployment options Modify default deployment options.

Modify study properties e Modify study projects and studies.

e Modify study properties in the Study Editor > Administration
tab and the Properties Browser.

Units Administration

Right Permissions

Modify the list of available Import a new units file into the database.
units in the system

Note: These rights provide access to functionality in the Central Designer Administrator
application.
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User Administration

Create and modify users Create and modify users.
View users View information about users.
Activate users Activate users.

Terminate and deactivate users Deactivate and terminate users.

Note: These rights provide access to functionality in the Central Designer Administrator
application.

Verbatim Types Administration

Right Permissions

Create and modify verbatim Create and modify verbatim types.
types

View verbatim types View verbatim types.

Remove verbatim types Remove verbatim types.

Note: These rights provide access to functionality in the Central Designer Administrator
application.

Web Farm Administration

Right Permissions

Set the machine on which the Specify the primary job scheduler, and configure the polling
Job Scheduler will be interval for retrieving the status of deployment.
processing tasks

View, export and delete event  View, export, and delete event log messages.
log messages stored in
database

Note: These rights provide access to functionality in the Central Desigher Administrator
application.
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Library roles—Right descriptions

The rights for a library role are granted to Central Designer users only when users are assigned to the
role as well as the corresponding library team.

Library Administration

Right Permissions

Modify library Administration e  Enable and disable libraries.

tab
: e Modity library properties in the Library Editor >
Administration tab and the Properties Browser.
Publish library objects Publish and unpublish study objects.

Perform team administration ~ Modify library teams.

Create templates and types Create templates and types.

Library Collaboration

Right Permissions

Modity collaboration notes Modity collaboration notes created by other users.
created by other users

Create and assign tasks Create, modify, and assign tasks.

Note: All users can view the Collaboration Notes Browser and Tasks Browser. All users can view
tasks and collaboration notes and can create collaboration notes. Users can modify and delete
collaboration notes and tasks that they create.

Library Design
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Right Permissions

Define and modify study e  Create, modify, and delete study workflows, study elements, and
workflow study events.

e Modify properties of study elements and study events in the
Properties Browser.

Create InForm forms e Mark InForm forms as templates.

e Create InForm form placeholders (but not design InForm forms
or add items).

o Delete InForm forms.
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Copy and link study e Copy study objects from a library to the library in which you are
objects from libraries working.
e Copy study objects from a study to the library in which you are

working,

Define, modify and delete o  Create, modify, delete, lock, and protect InForm review states.
Review States

Design forms, Items, and e  Create sections, items, codelists, and codelist items.

codelists ) ) ] ] ) ]
e Design and modify forms, sections, items, codelists, and codelist
items and their properties in the Properties Browser.
e Modify study events in the Study Event Editor > General tab.

Protect study objects in
libraries

Protect libraries and library study objects.

Unprotect study objects in e  Unprotect libraries and library study objects.
libraries

Library Help

Right Permissions

Modify study help Modify study object Help information.

Library Import Export

Right Permissions
Import library Import study objects into libraries.
Export library Export study objects from libraries.

Library Import Export Translations

Right Permissions
Export library translations Export text strings to be translated.
Import library translations Import translated text strings.

Library Jobs Browser

Right Permissions

View Job Log records Use the Jobs Browser and view job results in the Jobs Browser.
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Library Logical Schemas

Right Permissions

Create and modify logical e  View, create, and modify logical schemas, data sets, and data series.

schema objects . . _ .
e Modify logical schema properties in the Properties Browser.

Create and modify logical e  Add items to data series.

schema associations ) ) )
e On the Data Series Summary tab in the Form Editor and Study

Event Editor, modify when items on specific forms and study
events are mapped to a data series.

Library Rule Design

Import user-defined functions Import functions.

Define and modify constants Create and modify constants.

Define and modify InForm rule Create and modify InForm rule templates for data-entry rules.
templates

Define and modify InForm data-  Create and modify InForm data-entry rules.
entry rules

Library Translation

Right Permissions

Translate library components ~ Translate study objects and components.
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Study roles—Right descriptions

The rights for a study role are granted to Central Designer users only when users are assigned to the
role as well as the corresponding study team.

Study Administration

Right Permissions

Create study templates Create templates for studies.

Modify Study Administration — Modify study administration data in the Administration Editor.

Data

Modify Study Editor Modify study properties in the Study Editor > Administration tab
Administration tab and the Properties Browser.

Modify study goals and Modify information in the Study Editor > References tab.
references

Perform team administration ~ Modify study teams.

Study Annotated Studybook

Right Permissions

Create Annotated Study Books e  Create annotated study books.

e Edit annotated study book options.

Study Collaboration

Right Permissions

Modity collaboration notes Modify collaboration notes created by other users.
created by other users

Create and assign tasks Create, modify, and assign tasks.

Note: All users can view the Collaboration Notes Browser and Tasks Browser. All users can view
tasks and collaboration notes and can create collaboration notes. Users can modify and delete
collaboration notes and tasks that they create.
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Study Deployment

Right Permissions
Approve deployment request  Approve deployment requests.

Note: The right also gives you permissions to cancel deployments
with a status of Submitted or Scheduled.

Create and manage deployment Create and manage study deployment packages.
packages

Create deployment request Create deployment requests.

Publish and delete baselines Publish and delete baselines.

Note: You can validate a study if you have the Designer Login
right (available for application roles in the Application
Administration grouping).

Save deployment packages Save deployment packages.

Study Design

124

Right Permissions

Apply in-place revisions e Make in-place revisions to study objects.

Define or modify study e Create, modify, and delete study workflows, study elements,
workflow and study events.

e Modify properties of study elements and study events in the
Properties Browser.

e Modify study designs.

e Modify the title and shott title of the study's common visit.

Create InForm forms e Create InForm form placeholders (but not design InForm
forms or add items).

o Delete InForm forms.

Copy study objects from e Copy study objects from a library to the study.
libraries
Define, modify and delete e Create, modify, delete, lock, and protect InForm review states.

Review States

Design forms, items, and e Create sections, items, codelists, and codelist items.

codelists ) ) ) . )
e Design and modify forms, sections, items, codelists, and

codelist items and their properties in the Properties Browser.

e Modify study events in the Study Event Editor > General tab.
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Right Permissions

Protect study or study object e  Protect studies and study objects.

Unprotect study or study e Unprotect studies and study objects.
object

Unprotect study objects from e  Unprotect study objects that came from libraries.
libraties

Study Help
Right Permissions
Modify study help Modify study object Help information.
Study Import Export
Right Permissions
Import Study Import study objects into studies.
Export Study Export study objects from studies.

Study Import Export Translations

Right Permissions

Export study translations Export text strings to be translated.

Import study translations Import translated text strings.
Study Jobs Browser

Right Permissions

View Job Log records Use the Jobs Browser and view job results in the Jobs Browser.
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Study Logical Schema

Right Permissions
Create and modify logical e View, create, and modify logical schemas, data sets, and data
schema objects series.

e Modify logical schema properties in the Properties Browser.

Create and modify logical e Add items to data series.

schema associations ) ) )
e On the Data Series Summary tab in the Form Editor and

Study Event Editor, modify when items on specific forms and
study events are mapped to a data series.

Study Rule Design

Import user-defined functions Import functions.

Define and modify constants Create and modify constants.

Define and modify InForm rule Create and modify InForm rule templates for data-entry rules.
templates

Define and modify InForm data-  Create and modify InForm data-entry rules.
entry rules

Study Translation

Right Permissions

Translate study components  Translate study objects and components.
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Adding units and conversion
calculations

In this appendix

About units and conversion calculations

Conversion calculation XML definition

Editing the UNIts fIle ..c.vcuieuieciieiricirieieeieeereetseeeiesesese e sasaees

Units defined in the units file
Conversion calculations defined in the units file

Supported locales and their abbreviations
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About units and conversion calculations

128

When you create integer or float items, you can specify the base unit and one or more conversion
units in which users can enter data. The available units and their conversion calculations are stored in
the database. To specify additional units and conversion calculations or to provide locale-specific
abbreviations, you must export the units file using the Central Designer Administrator application,
edit it, and import the file using the Central Designer Administrator application.

After you update and save the file, the next time a user logs on to the Central Designer application,
the new unit definitions are available.
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Unit XML definition

The definition of a unit is in the following format:

<Unit Name="name''>
<ConversionMap>name</ConversionMap>
<Locale Name="name'>
<DisplayString>string</DisplayString>
<DisplaySymbol>string</DisplaySymbol>

</Locale>
</Unit>
XML object Description
Unit Definition of the unit. A Unit object includes one or more Locale objects.

Name—Locale-independent name for the unit. Use this name as the value of
the From or To attribute in the definitions of conversion calculations for this
unit.

ConversionMap  Name of the conversion definition. Use the value of the Name attribute of the
applicable UnitConversionMap object. For more information, see Conversion
calculation XML definition (on page 130).

Locale Definition of the locale. A Locale object includes a DisplayString and a
DisplaySymbol definition.

Locale Name—International standard locale name, in the format xx-XX.

For more information, see Supported locales and their abbreviations (on
page 134).

DisplayString Display string for the unit in the specified locale.

DisplaySymbol ~ Symbol for the unit in the specified locale. This symbol is displayed in the Item
Editor for item types that allow units and in the Layout tab.

XML example

<Unit Name="in">
<ConversionMap>Length</ConversionMap>
<Locale Name="en-US">
<DisplayString>Inches</DisplayString>
<DisplaySymbol>in</DisplaySymbol>
</Locale>
</Unit>
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Conversion calculation XML definition

The definition for a conversion calculation is in the following format:

<UnitConversionMap Name="name'" Classification=""name">
<UnitConversion From="name" To="name">{value}formula</UnitConversion>
</UnitConversionMap>

XML object Description

UnitConversionMap Definition of the type of measurement represented by the unit. Each
UnitConversionMap object can include multiple UnitConversion
definitions. The UnitConversionMap object has the following attributes:

e Name—Name of the UnitConversionMap object. This name is the
same as the ConversionMap name in the definition each unit
included in a conversion calculation definition.

e Classification—Classification of the UnitConversionMap object.
This name matches the corresponding classification type in the
MedML definition of a unit in the InForm application.

UnitConvetsion Formula used to convert one unit value to another. The UnitConversion
object has the following attributes:

e From—Name attribute of the Unit object from which to make the
conversion.

e To—Name attribute of the Unit object to which to make the
conversion.

XML example

<UnitConversionMap Name="Temp" Classification="Temperature'>
<UnitConversion From="Cent" To="Fahren">({value}*9/5)+32</UnitConversion>
<UnitConversion From="Fahren" To="Cent">({value}-32)*5/9</UnitConversion>
</UnitConversionMap>
<UnitConversionMap Name="Weight"™ Classification="Weight'>
<UnitConversion From="Pounds" To="Kilogram">{value}*0.454</UnitConversion>
<UnitConversion From="Kilogram" To=""Pounds">{value}*2._205</UnitConversion>
<UnitConversion From="0Ounce" To="Gram">{value}*28.35</UnitConversion>
<UnitConversion From="Gram" To="‘Ounce'>{value}/28.35</UnitConversion>
</UnitConversionMap>
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Editing the units file

The available units and their conversion calculations are stored in the database. To specify additional
units and conversion calculations or to provide locale-specific abbreviations, you must export the
units file using the Central Designer Administrator application, edit it, and import the file using the
Central Designer Administrator application.

If you edit the units file:
e Create a backup copy of the file before making any changes.

e Oracle recommends adding to the file, rather than deleting or changing existing entries.

To make this type of change Add these objects

Add a unit. Unit, including a ConversionMap object and one or
more Locale objects.

Add a locale to an existing unit. Locale, including a DisplayString and DisplaySymbol
object.
Add a conversion calculation for a unit.  UnitConversion. If adding a conversion calculation to a

unit that represents a type of measurement not already
included in the file, add a UnitConversionMap object
for that type of measurement.
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Units defined in the units file

Units are defined in Unit objects.

Unit type Unit Name attribute DisplaySymbol value
Beats per Minute BPM bpm
Breaths per Minute BreathsPerMinute BM
Centigrade Cent C
Centimeters cm cm
Fahrenheit Fahren F
Feet foot ft
Grams Gram g
Inches in in
Kilograms Kilogram kg
Pounds Pounds Ibs
Meters meter m
Millimeters mm mm
Milliseconds msec msec
Ounces Ounce 0z
Seconds seconds sec
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Conversion calculations defined in the units file

Conversion calculations are defined in UnitConversion objects, which are child objects of the
UnitConversionMap object. From and To attributes of the UnitConversion object match the Name
attribute of the Unit object.

UnitConversion From UnitConversion To attribute  UnitConversion value

attribute

Length conversion

in cm (value) * 2.54

in meter (value) * 0.0254
in km (value) * 2.54 / 100000
in mm (value) * 25.4

in foot (value) / 12

foot in (value) * 12

cm in (value) / 2.54

cm meter (value) / 100

cm km (value) / 100000
cm mm (value) * 10

cm foot (value) / 2.54 / 12
foot meter (value) * .3048
meter foot (value) * 3.2808
mm cm (value) / 10

mm in (value) / 25.4

Temperature conversions

Cent Fahren ({value} *9/5) + 32

Fahren Cent ({value} -32)*5/9

Weight conversions

Pounds Kilogram (value) * 0.454
Kilogram Pounds (value) * 2.205
Ounce Gram (value) * 28.35
Gram Ounce (value) / 28.35
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Supported locales and their abbreviations

Locale Abbrev. Locale Abbrev. Locale Abbrev.
Afrikaans (South af-ZA Finnish (Finland) fi-F1 Russian (Russia) ru-RU
Africa)

Albanian (Albania) sq-AL French (Belgium) fr-BE Sami, Inari (Finland) smn-FI

Arabic (Algeria) ar-DZ French (Canada) fr-CA Sami, Lule (Norway) smj-NO

Arabic (Bahrain) ar-BH French (France) fr-FR Sami, Lule (Sweden) smj-SE
Arabic (Egypt) ar-BEG French fr-LU Sami, Northern se-F1
(Luxembourg) (Finland)
Arabic (Iraq) ar-1Q French (Principality  fr-MC  Sami, Northern se-NO
of Monaco) (Norway)
Arabic (Jordan) ar-JO French (Switzerland) fr-CH  Sami, Northern se-SE
(Sweden)

Arabic (Kuwait) ar-KW  Frisian (Netherlands) fy-NL ~ Sami, Skolt (Finland) sms-FI

Arabic (Lebanon)  ar-LB Galician (Galician)  gl-ES Sami, Southern sma-NO
(Norway)
Arabic (Libya) ar-LLY Georgian (Georgia) ka-GE  Sami, Southern sma-SE
(Sweden)
Arabic Morocco)  ar-MA German (Austria) de-AT  Sanskrit (India) sa-IN
Arabic (Oman) ar-OM German (Germany) de-DE  Serbian (Cyrillic, sr-Cytl-
German de-LI Islosrna an.d BA
(Liechtenstein) erzegovina)
Arabic (Qatar) ar-QA German de-LU  Serbian (Cyrillic, st-Cyrl-
(Luxembourg) Serbia) CS
Arabic (Saudi ar-SA German de-CH  Setbian (Latin, st-Latn-
Arabia) (Switzerland) Bosnia and BA
Herzegovina)
Arabic (Syria) ar-SY Greek (Greece) el-GR  Serbian (Latin, sr-Latn-
Serbia) CS
Arabic (Tunisia) ar-TN Gujarati (India) gu-IN  Sesotho sa Leboa na-ZA
(South Africa)
Arabic (U.A.E) ar-AB Hebrew (Israel) he-1L Setswana (South tn-ZA
Africa)
Arabic (Yemen) ar-YE Hindi (India) hi-IN Slovak (Slovakia) sk-SK
Armenian hy-AM  Hungarian (Hungary) hu-HU  Slovenian (Slovenia) sl-SL
(Armenia)
Azeri (Cyrillic, az-Cytl-  Icelandic (Iceland) is-1S Spanish (Argentina) es-AR
Azerbaijan) AZ
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Locale Abbrev. Locale Abbrev. Locale Abbrev.

Azeri (Latin, az-Latn-  Indonesian id-ID Spanish (Bolivia) es-BO

Azerbaijan) AZ (Indonesia)

Basque (Basque) eu-ES Inuktitut (Latin, tu-Latn-  Spanish (Chile) es-CL
Canada) CA

Belarusian (Belarus) be-BY Irish (Ireland) ga-1E Spanish (Colombia) es-CO

Bosnian (Cyrillic, bs-Cytl-  Italian (Italy) it-IT Spanish (Costa Rica) es-CR

Bosnia and BA Italian (Switzerland)  it-CH

Herzegovina)

Bosnian (Latin, bs-Latn-  Japanese (Japan) ja-JP Spanish (Dominican es-DO

Bosnia and BA Republic)

Herzegovina)

Bulgarian (Bulgaria) bg-BG ~ Kannada (India) kn-IN  Spanish (Ecuador)  es-EC

Catalan (Catalan) ca-ES Kazakh kk-KZ  Spanish (El es-SV
(Kazakhstan) Salvador)

Chinese (Hong zh-HK  Kiswahili (Kenya) sw-KE  Spanish (Guatemala) es-GT

Kong S.AR) Konkani (India) kok-IN

Chinese (Macao zh-MO  Korean (Korea) ko-KR  Spanish (Honduras) es-HN

S.AR)

Chinese (People's  zh-CN Kyrgyz (Kyrgyzstan) ky-KG  Spanish (Mexico) es-MX

Republic of China) Latvian (Latvia) Iv-LV

Chinese (Singapore) zh-SG Lithuanian It-LT Spanish (Nicaragua) es-NI
(Lithuania)

Chinese (Taiwan) zh-TW  Luxembourgish Ib-LU  Spanish (Panama) es-PA
(Luxembourg)

Croatian (Bosnia hr-BA Macedonian (Former mk-MK  Spanish (Paraguay)  es-PY

and Herzegovina) Yugoslav Republic
of Macedonia)

Croatian (Croatia)  hr-HR Malay (Brunei ms-BN  Spanish (Peru) es-PE
Darussalam)

Czech (Czech cs-CZ Malay (Malaysia) ms-MY  Spanish (Puerto es-PR

Republic) Rico)

Danish (Denmark) da-DK = Maltese mt-MT  Spanish (Spain) es-ES

Divehi (Maldives)  dv-MV ~ Maori mi-NZ  Spanish (Uruguay) es-UY

Dutch (Belgium) nl-BE Mapudungun (Chile) arn-CL.  Spanish (Venezuela) es-VE

Dutch nl-NL Marathi (India) mr-IN  Swedish (Finland) sv-FI
(Netherlands)

English (Australia)  en-AU Mohawk (Mohawk) moh-CA Swedish (Sweden) sv-SE
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Locale Abbrev. Locale Abbrev. Locale Abbrev.

English (Belize) en-BZ Mongolian (Cyrillic, mn-MN  Syriac (Syria) syr-SY
Mongolia)

English (Canada) en-CA Nepali (Nepal) ne-NP  Tamil (India) ta-IN

English (Caribbean) en-029 Norwegian, Bokmédl nb-NO  Tatar (Russia) tt-RU
(Norway)

English (Ireland) en-1E Norwegian, Nynorsk nn-NO  Telugu (India) te-IN
(Norway)

English (Jamaica) en-]M Pashto (Afghanistan) ps-AF  Thai (Thailand) th-TH

English (New en-NZ Persian (Iran) fa-IR Turkish (Turkey) tr-TR

Zealand)

English (Republic ~ en-PH Polish (Poland) pl-PL Ukrainian (Ukraine) uk-UA

of the Philippines)

English (South en-ZA Portuguese (Brazil)  pt-BR  Utrdu (Islamic ur-PK

Africa) Republic of Pakistan)

English (Trinidad ~ en-TT Portuguese pt-PT  Uzbek (Cyrillic, uz-Cytl-

and Tobago) (Portugal) Uzbekistan) uz

English (United en-GB Punjabi (India) pa-IN  Uzbek (Latin, uz-Latn-

Kingdom) Uzbekistan) uz

English (United en-US Quechua (Bolivia) quz-BO  Vietnamese vi-VN

States) (Vietnam)

English en-ZW  Quechua (Ecuador) quz-EC  Welsh cy-GB

(Zimbabwe)

Estonian (Estonia) et-EE Quechua (Peru) quz-PE  Xhosa xh-ZA

Faroese (Faroe fo-FO Romanian (Romania) ro-RO  Zulu zu-ZA

Islands)

Filipino fil-PH Romansh rm-CH

(Philippines) (Switzerland)
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A

annotated study book

A form-by-form summary of the design of a study.
Optionally, it includes a time and events schedule, a
preview of each form, and selected annotations that
list design details.

See also study book (on page 144).

application role

A role associated with administrative activities.

arm

See study arm (on page 144).

authentication

The method of ensuring that you are using the
correct user name and password to log on.
authorization

The method of giving users access to information or
functionality. Access is controlled using rights, roles,
and teams.

automated deployment

The process through which a deployment package is
sent directly from the Central Designer application
to the InForm application and installed without
additional action requitred.

baseline

A snapshot of all components in a study. Validation
creates a baseline.

Baselines Browser

A browser in which you view the results of
validation and make temporary baselines public so
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that other users can work with them.

branch

See study branch (on page 144).

C

calculation rule

A rule that sets the value of an item based on a
calculation.

catalog

A collection of categories and keywords that can be
attached to users and study objects to facilitate
searching in the Libraries Browser and Users
Browser.

catalog administration

The process of creating keywords and categories and
assigning them to users and study objects for faster
and more sophisticated searching.

category

A hierarchical grouping of keywords. You can create
categories only from existing keywords.

CDISC

Clinical Data Interchange Standards Consortium.
CDISC is an open, multidisciplinary, non-profit
organization committed to the development of
industry standards to supportt the electronic
acquisition, exchange, submission and archiving of
clinical trials data and metadata for medical and
biopharmaceutical product development.

checkbox

A type of data entry control in which you can select
one or more options by selecting the box that
represents each option.
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clinical project

See study project (on page 144).

clinical protocol

See protocol (on page 142).

clinical study

See study (on page 143).

codelist

A collection of code-label pairs that gather together
the entry choices for an item. A code-label pair
consists of a single code (the value that is used for
analysis) and a label (the value that is visible to
users).

See also codelist item (on page 138).

codelist item

A code-label pair consisting of a single code (the
value that is used for analysis) and a label (the value
that is visible to users). Multiple codelist items make
up a codelist.

See also codelist (on page 138).

coding

The process of selecting terms and codes from a
dictionary for a verbatim.

coding dictionary

A standardized collection of terms and the codes
that correspond to those terms.

coding map

A study object that contains the necessary
information to code an item.

coding target

See tazget item (on page 145).

collaboration

The process by which users with different roles and
specialties can work together to create, validate, and
deploy a study.
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collaboration note

A note that you attach to any study object.

collaboration note type

A classification used to identify the type and purpose
of a collaboration note.

Collaboration Notes Browser

A browser in which you work with collaboration
notes.

common form

A form that is designed for use with multiple study
events. The same data appears in the form in all
study events in which the form is used.

component

Any design building block that is configured in a
study or library. Design components include study
objects (such as a project, study, study element,
study event, form, or item) as well as rules,
individual items selected from drop-down lists, and
controls (such as checkboxes and radio buttons).

compound item

An item that has one or more child items that can
have different data types.

constant

A value that is defined in a library or study and that
can be referenced by any rule.

constraint rule

A rule that checks whether data is valid. Constraint
rules are used to confirm that clinical data meets the
requirements of the clinical protocol.

container

A node in the Project Explorer that contains zero or
more study objects or components.

context item

An item that provides additional coding information,
such as the indication and route of administration
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for drugs, that can be displayed with an item coded
using the WHO-DD dictionary.

CSML

Clinical Study Markup Language. CSML is an XML-
based markup language developed by Oracle for
representing and exchanging clinical data definitions
created in the Central Designer application.

See also MedML (on page 142).

custom data dimension

See data dimension (on page 139).

custom property

A user-defined or default characteristic of a study
object.

D

data dimension

A key item for a data set. A data dimension specifies
the additional information that will be saved when
study data is collected. You can specify standard data
dimensions (Study, Subject, Event and Event Index,
Form and Form Index, and Item) and custom data
dimensions.

data series

A grouping of one or more items with the same
clinical meaning, such as one or more items that
measure weight.

See also data set (on page 139), mapping (on page
141).

data set

A grouping of one or more related data series.

See also data series (on page 139), mapping (on
page 141).

data type

An attribute for items and data series. For an item,
the data type determines the type of entry an item
will accept. For a data series, the data type
determines which items can be added to it. Data
types include date time, integer, float, and text.
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data-entry rule

A rule that checks whether data is valid or that sets
the value of an item based on a calculation.

See also workflow rule (on page 140).

date time item

An item used to collect date and time information
on a form.

deployment

The process of sending a study to a target
application. To collect data, a study must be
deployed into a target application as a complete
deployment package.

deployment approval

The optional process by which a study deployment
is approved by a user with the appropriate rights.

deployment instance

The server to which you deploy a study.

deployment request

A request from a user with the appropriate rights to
initiate an automated deployment to the InForm
application.

dictionary metadata item

An identifier that describes administrative data about
a dictionary and that you can use to create a coding
map.

dictionary type

A name or identifier for the metadata for a
dictionary.

drop-down list

A data entry format in which you select an option
from a list.

dynamic form

A form that is automatically generated in the
InForm application when subject data satisfies
certain criteria tested in another form.
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dynamic visit

A visit that is automatically generated in the InForm
application when patient data satisfies certain criteria
tested in another visit.

E
edit check

A data-entry rule that checks whether entered data is
valid.

See data-entry rule (on page 139).

element

See study element (on page 144).

event

See study event (on page 144).

explicit lock
A lock that you request and that does not expire.

See also implicit lock (on page 140).

expression

The part of a rule that specifies what to evaluate.

field

The area in a data-entry window where the value for
an item is entered or displayed.

float item

An item used to collect numerical values with
decimal points.

form

A container for one or more items. A form can
contain one or more sections and supports multiple
locales and layouts. A form is deployed to a target
application as a data-entry form used to collect
subject information and other clinical data.

full installation deployment package

A deployment package that contains everything
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needed to deploy a complete study.

function

A reusable piece of code that extends the behavior
of a rule. A function can be predefined or user-

defined.

G

global condition

A logical construct that, when applied to a study
object, determines whether the study object will
appear for a particular subject. A global condition
does not affect other study objects in the workflow.

See also workflow rule (on page 140).

globals

Study objects and properties that are related to
mappings.

grouping

A default or user-provided value used to organize
custom properties of a study object.

implicit lock

A type of lock used when you edit a study object. An
implicit lock is automatically applied when you select
or open a study object and is automatically released
when you close or save a study object.

See also explicit Iock (on page 140).

incremental deployment package

A deployment package that contains a complete
study based on a previously created deployment
package, plus any additions or changes.

in-place revision (IPR)

A study design change that is applied to existing
study versions previously deployed to the InForm
application.
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integer item

An item used to collect a numerical value without a
decimal point.

internationalization

The process of configuring a study for translation
into different languages or for different regional
requirements.

intrinsic rule

A constraint rule or calculation rule based on a
predefined rule template.

item

A study object used as a container for the collection
of clinical data.

item group

A study object used to combine items so that you
can set their display override options in the InForm
application.

J

Job Log Browser

A browser in which you view the results of
asynchronous jobs, such as validation or impott.

K

keyword

An identifier that is associated with users and study
objects to facilitate more powerful and efficient
searches.

L

Libraries Browser

A browser in which you search the repository for
study objects and then add them to studies or
libraries.
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library

A container used to store related study objects and
templates to be published for reuse in studies or
other libraries. A library provides a view of the study
objects in the repository.

See also repository (on page 143).

Library List

A hierarchical list of libraries from which resources
can be used. The hierarchy determines the order in
which libraries are searched. The Library List is
defined for each study in the Study Editor.

library project

A project containing a library.

library role

A role associated with library activities.

library team

A group of users who have rights granted by a
certain role to perform tasks in a particular library.
locale

A supported language or language variation.

localization

The process of designing a study for a specific
locale.

locked

A state in which only the user who created the lock
can modify a study object. Locks can be implicit or
explicit.

See also implicit lock (on page 140), explicit lock
(on page 140).

M
mapping

A data grouping that provides an alternate data view
of a study. Mappings were previously called logical
schemas.

See also data series (on page 139), data set (on
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page 139).

MedML

An XML-based markup language developed by
Oracle for representing and exchanging clinical data
definitions created in the InForm application..

See also CSML (on page 139).

method

A block of code that is called by a rule and that is
used to manipulate data.

normalization

The process of converting data to a required format.

0

object

See study object (on page 144).

ODM

Operational Data Model. ODM is an XMI.-based
standard developed by the Clinical Data Interchange
Standards Consortium (CDISC) for representing
and exchanging clinical data.

P

precondition

The part of a rule that specifies when to evaluate the
rule expression.

project

See library project (on page 141) and study project
(on page 144).

Project Explorer

A browser that displays a view of the open project
and the study objects it contains.

Properties Browser

A browser in which you can view and modify the
properties of the study object selected in the Project
Explorer.
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property

A defining characteristic of a study object.

protocol

A detailed plan that describes how investigators
conduct a study. The clinical protocol sets the
guidelines for the study, describes the conditions of
the study, and contains a set of forms on which
clinical data is collected.

publish

The action that makes a study object created in a
library available to other usets.

See also unpublish (on page 145).

Q

query

A text string that appears on a CRF item in the
InForm application when a rule on that item fails.
When designing a rule in the Central Designer
application, you can specify the query text and the
circumstances under which a rule results in a query.

query group

A study object used to specify the users who can act
on queties created by other members of the group in
the InForm application.

R

radio button

A type of data entry format in which you must select
a single item from a list of choices.

reference

A text note, a link to a Web page or file (URL), a
document, or a combination of all three, that is
attached to a study project for users to consult
during the development of a study.

RefName

A unique identifier for a study object.

repeating form

A type of form for which the Repeating property is
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set to true. You use a repeating form to collect
multiple instances of the same data at different dates
and times.

repository

A single database instance that contains all Central
Designer study objects, components, and users.
revision

An audit history record that is created automatically
when a user edits a study object and saves the
changes.

right

A predefined permission that controls access to a
specific feature or activity in the Central Designer
client or Central Designer Administrator client and
that can be assigned to one or more roles.

See also role (on page 143).

rights group

A study object used to create a set of predefined
InForm rights in the InForm application.

role

A collection of rights. When a user is assigned to a
role, the rights associated with the role are granted
to the user.

See also library role (on page 141), study role (on
page 144), and user role (on page 145).
role administration

The process of managing tasks that users perform in
the Central Designer and Central Designer
Administrator applications, assigning rights to roles,
and assigning roles to users.

rule
See data-entry rule (on page 139), workflow rule
(on page 146).

rule action

The action, or actions, that takes place as a result of
the evaluation of a rule expression.
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rule scope

The set of study objects that a rule can reference.
The scope of a rule is determined by the study
object on which the rule is defined.

rule template

A function that is defined on a study object, study
object template, or study object type and can be
used as the expression clause of a rule.

rule type

See calculation rule (on page 137), constraint rule
(on page 138), and Intrinsic rule (on page 141).

S
SDTM

Study Data Tabulation Model. SDTM is a CDISC
model used to standardize data structures in data
extracts.

shared form

See common form (on page 138).

signature group

A study object used to specify the forms that require
signature and the signature type in the InForm
application.

site

A location that participates in a study.

sponsor

A study object used to define the sponsor properties
of a study, such as name or address, in the InForm
application.

standard data dimension

See data dimension (on page 139).

standard task type

A task type that is typically used for all non-
translation tasks assigned to an individual or team.
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study

The definition of the workflow, data-entry, and data-
management system for a clinical study.

study administration object

A collection of study objects that are used to capture
study administration data for deployment to the
InForm application.

See also jtem group (on page 141), query group
(on page 142), rights group (on page 143),
signature group (on page 143), sponsor (on page
143), study configuration (on page 144).

study arm

The CDISC term for a study branch consisting of a
planned sequence of study elements. A study arm is
typically equivalent to a treatment group.

study book
The set of forms used to collect clinical data.

See also annotated study book (on page 137).

study branch

A path for which data is collected for certain
subjects. A study can contain multiple branches as
different conditions are assessed, and a branch is
followed depending on the subject and other
circumstances.

study configuration

A study object used to specify the value of an
InForm configuration variable in the InForm
application.

study design

A container for the structure of a study.

study element

The CDISC term for a basic building block of a
study. A study element represents a segment of a
study and can consist of one or more study events.
Study elements are optional.
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study event

A subject evaluation checkpoint when data is
collected. Study events usually correspond to visits,
but one visit can span multiple study events.

study object

A study building block that appears in the Project
Explorer. Study objects include study projects,
libraty projects, studies, libraties, study elements,
study events, forms, sections, items, codelists,
codelist items, deployment instances, in-place
revisions, and study administration objects.

See also component (on page 138) and study
administration object (on page 144).

study object editor

An editor for each study object, such as a project,
study, study element, study event, form, or item. A
study object editor appears in the workspace when
you select a study object.

study project

A project containing one or more studies that are
related to each other.

study role

A role associated with study activities.

study team

A group of users who perform tasks granted by a
certain role for a particular study.

study workflow

See workflow (on page 140).

subject

An individual who participates in a clinical study.

system

An application to which you deploy a study from the
Central Designer application.

system configuration administration

The process of creating, configuring, and managing
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internationalization, collaboration, and
customization information using the Central
Designer Administrator application.

T

target item

An item that holds a term, code, or additional
information after a verbatim is coded.

task

A request that you attach to a study object and
assign to an individual or a study team.

task classification

The classification of a task. You can choose either
standard (used for all non-translation tasks assigned
to an individual or team) or translation (used for
tasks that request translation of a study object into
one or more languages). You define the classification
for task types in the Central Designer Administrator
application.

task type
A classification used to identify the type of the task
and the way the task is used.

Tasks Browser

A browser in which you work with tasks.

team

See study team (on page 144), library team (on
page 141).

template

A study object that is either partially or fully defined
and that can be used to create other study objects.
You can create templates for study projects, studies,
study elements, study events, forms, items, codelists,
and mappings.

text box

A data-entry format in which you type data.
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text item

An item used to collect alphanumeric information.

translation task type

A task type that is used for tasks that request
translation of a study object into one or more
languages.

type

A study object that is either partially or fully defined
and can be used to create other study objects. Types
are like templates except that types appear as options
in the Actions menu and in the Project Explorer
menu when you create a new study object.

U

unpublish

The action that makes a study object in a library no
longer available to other users.

See also publish (on page 142).

user

A person who works in the Central Designer or
Central Designer Administrator application.
user administration

The process of managing users.

user role

A role associated with user activities.

Users Browser

A browser in which you search the repository for
users and then add them to study teams or library
teams.

v

validation

The process of checking the status of a study to
indicate if the study is ready for deployment. The
study validation process determines whether all
essential components exist and are consistent.
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verbatim

The original reported text that describes the adverse
event, disease, drug, or other item to be coded in the
Central Coding application.

verbatim type

A classification of a verbatim as defined in a coding
dictionary.

version

An explicitly requested audit history record for a
study object.

visit

See study event (on page 144).

w

workflow

The progression of work for a study, as determined
by the study designers.

workflow rule

A logical construct that tests data values to
determine the study element, study event, or form to
which a subject progresses next. A workflow rule
prevents study objects in the workflow from
appearing until the rule is evaluated.

See also data-entry rule (on page 139), global
condition (on page 140).

workspace

The work area of the Central Designer and Central
Designer Administrator applications. The contents
of the workspace depend on the type of activity you
are performing and the rights that you have been
granted. The workspace displays the editor for the
study object that is selected in the Project Explorer.

Y

yes no item

An item used to collect yes or no answers to
questions. A yes no item contains a predefined
codelist with Yes and No options.

146 Oracle® Health Sciences Central Designer 2.1



Index

Create Role dialog box ¢ 46
Create User dialog box * 34
Custom Properties workspace

A

active status * 29

application roles * 113 about ¢ 65
field descriptions ¢ 73
C custom property

adding, modifying, and removing ¢ 63
Central Designer application * 72

Clintrial and InForm custom properties * 66
grouping of * 64

Catalog workspace * 95
catalogs
Catalog workspace * 95
copying a keyword ¢ 92
creating and deleting a keyword * 91 D
creating and removing a category ® 92
cutting, copying, or pasting a category ® 93
searching for a keyword ¢ 91
workflow for categorizing in * 94
categorization in Central Designer
categorizing a user * 25
workflow for categorizing users * 94
Categorization tab

dictionary metadata
Coding Dictionary Metadata workspace * 81, 82
importing and overwriting * 79
dictionary type in Central Designer
Dictionary types workspace ¢ 79, 82
enabling and disabling ¢ 77
importing and overwriting * 77

about * 29 renaming ¢ 78

list descriptions * 34 Dictionary Types workspace
category about ¢ 79' .

checklist for using ¢ 90 field descriptions 82

creating and removing * 92 E

cutting, copying, and pasting * 93

types of categories * 95 Event Log Messages workspace * 98, 99

workflow for cagegorizing * 94 export in Central Designer
Central Designer applications, about * 2, 3, 4, 6 exporting sponsor information ¢ 54
Change Password dialog box ¢ 35 exporting system settings * 56
checklists

creating and using key * 90 F

creating users and roles * 18 fluency skill » 24

setting up in Central Designer Administrator for

translating text strings ¢ 50 G

Clintrial application
Clintrial custom properties * 66
Coding Dictionary Metadata workspace

grouping of custom properties
adding and removing * 64
moving, cutting, copying, and pasting ¢ 64

about ¢ 81
option descriptions * 82 H
coding setup and administration
dictionary metadata ¢ 79, 81 help, getting ¢ 5, 7

dictionary type * 77, 78, 79 I
verbatim type ¢ 78, 81

collaboration note in Central Designer import in Central Designer
collaboration note type * 59 importing sponsor information ¢ 53

collaboration note type importing system settings ¢ 56
adding, modifying, and deleting * 59 inactive status ® 29
Note Types workspace * 60, 61 InForm application

contact information ¢ 23 custom properties * 66

conversion to different units * 128, 130, 133
Copy User dialog box * 34

Oracle® Health Sciences Central Designer 2.1 147



Index

library roles * 120

J study roles * 123

Job Scheduler Manager workspace * 100, 101, 102 viewing rights granted to a user ¢ 23
Rights tab

K about © 42

option descriptions * 45
role in Central Designer
about * 11
assigning a user to * 23, 30, 40
assigning rights to * 40
checklist for creating ¢ 18
copying * 39
creating * 38
default roles ¢ 47
deleting * 38
modifying * 39, 40
removing a user from * 24, 41
removing rights from ¢ 40
role scope * 112

keyboard shortcuts * 106
Catalog workspace * 108
Custom Properties workspace * 107
opening menus * 106
Roles workspace ¢ 107
Users workspace * 106
keywords
checklist for using ¢ 90
copying ® 92
creating and deleting * 91
Searching a catalog for ¢ 91
types ® 95
workflow for categorizing ¢ 94

L Roles workspace
about * 42
library roles * 120 refreshing * 38
locale
abbreviations for * 134 S

adding and removing * 50
Supported Locales workspace ¢ 51
locks
object-level locking ¢ 12
logging on and off * 13

saving * 14

scope, role * 112
security settings ® 83
Security workspace

about * 83
N option descriptions * 83
server, web farm ¢ 100, 101
Note Types workspace Skills tab
about ¢ 60 about * 28
field descriptions ¢ 61 changing the view of * 24
0 field descriptions ¢ 34
specifying language fluency skills ¢ 24
online Help ¢ 5,7 sponsor ¢ 53, 54
startup
P logging on and off * 13
password status bar

changing * 22 option descriptions ¢ 109

requiring a user to change a password ¢ 22 study roles * 123

Personal Info tab supported locale
about * 26 list of abbreviations for ¢ 134

Supported Locales workspace ¢ 51

field descriptions ¢ 33 :
system settings ® 56

properties in Central Designer

custom properties for Clintrial and InForm * 63, 64, T
66, 72
Propetties tab of the Roles workspace target application * 52
about * 42 task type * 59
field descriptions * 45 Task Types workspace
about * 61
R field descriptions ¢ 62
redoing * 15 terminated status ¢ 29
resetting * 14 terminology ) o
rights in Central Designer Central Demgng Administrator terms * 6
about * 11, 112 terms, Central Designer Administrator ¢ 6

toolbar ¢ 109

application roles * 113 o .
translation in Central Designer

for default roles * 47

148 Oracle® Health Sciences Central Designer 2.1



Administrator Guide

locales for * 50, 51, 134 workspace
setting up in Central Designer Administrator for about * 10
translating text strings ¢ 50 Custom Properties workspace * 65
text string * 50 in the Central Designer Administrator application * 10

Note Types workspace * 60

U Roles workspace ¢ 42

undoing * 15 Sponsors workspace * 53, 54

anit Supported Locales workspace ¢ 51
about * 128 System Settings workspace * 56
conversion calculation XML defintion * 130 Task types workspace * 61
file * 76, 131, 132, 133 Users workspace * 26

Units Definitions workspace ¢ 76
XML definition ¢ 129, 130
Units Definitions workspace ¢ 76
User Info tab
about * 26
field descriptions ¢ 32
User Roles tab
about * 26
list descriptions * 34
user, Central Designer and Central Designer
Administrator
about * 11
activating, deactivating, terminating * 21
categorizing * 25
Central Designer Administrator users * 3
Central Designer users * 4
changing ¢ 22, 23
copying * 20
creating * 18, 20
default users ¢ 31
finding * 21
passwords * 22
removing * 24, 41
role assignment ¢ 23, 30, 40
specifying language fluency skills * 24
statuses of users * 29
viewing rights * 23
Users list * 21
Users tab
about * 44
list descriptions * 46
Users view ® 32
Users workspace
about * 26
refreshing * 21

'

verbatim in Central Designer
type * 78, 81
Verbatim Types workspace * 81
views
about * 10

W

wb farm
Event Log messages and * 98, 99
primary job scheduler forf ¢ 100, 101, 102
servers in * 100, 101

Oracle® Health Sciences Central Designer 2.1 149



	About this guide
	Overview of this guide
	Audience

	Documentation
	Documentation accessibility

	If you need assistance
	Finding Central Designer information and patches on My Oracle Support
	Creating a My Oracle Support account
	Finding information and articles
	Finding patches

	Finding Oracle documentation
	Finding Oracle Health Sciences documentation
	Finding other Oracle documentation

	Finding prerequisite software for Oracle Health Sciences applications


	Introduction to the Central Designer Administrator and Central Designer applications
	About Central Designer applications
	About the Central Designer Administrator application and users
	About the Central Designer application and users
	Getting help
	Central Designer Administrator terms
	Troubleshooting issues with Help

	Accessing the Central Designer Administrator application
	Workspaces and views
	Users, rights, and roles
	Object-level locking
	Logging on and off
	Saving and resetting in the Central Designer Administrator application
	Undoing and redoing one or more actions

	User administration
	Checklist—Creating and configuring users and roles
	Working with users
	Creating a user
	Copying a user
	Activating, deactivating, and terminating a user
	Filtering and searching the Users list
	Refreshing the Users workspace
	Changing the display name of a user
	Changing the password of a user
	Requiring users to change their passwords
	Changing the contact information of a user
	Viewing the rights granted to a user
	Assigning a single user to one or more roles
	Removing a user assignment from one or more roles
	Changing the view of the Skills tab
	Specifying the language fluency skills of a user
	Categorizing a user with keywords and categories

	About the Users workspace
	User Info tab
	Personal Info tab
	User Roles tab
	Skills tab
	Categorization tab
	Statuses of users
	About assigning users to roles
	Default users

	Option descriptions for the Users view and workspace
	Users view—Option descriptions
	User Info tab—Field descriptions
	Personal Info tab—Field descriptions
	User Roles tab—List descriptions
	Skills tab—Field descriptions
	Categorization tab—List descriptions
	Create User and Copy User dialog boxes—Field descriptions
	Change Password dialog box—Field descriptions


	Role administration
	Working with roles
	Refreshing the Roles workspace
	Creating a role
	Deleting a role
	Copying a role
	Modifying the name or description of a role
	Assigning rights to a role
	Removing rights from a role
	Assigning one or more users to a single role
	Removing a user from a role

	About the Roles workspace
	Properties tab
	Rights tab
	About assigning users to roles
	Users tab

	Option descriptions for the Roles view and workspace
	Properties tab—Field descriptions
	Rights tab—Option descriptions
	Users tab—List descriptions
	Create Role dialog box—Field descriptions

	Default roles
	Rights assigned to the StudyDesigner role
	Rights assigned to the StudyAdministrator role
	Rights assigned to the DesignerAdministrator role


	System configuration administration
	Working with supported locales
	Checklist—Setting up in Central Designer Administrator for translating text strings
	Adding and removing a locale
	Supported Locales workspace
	Supported Locales workspace—Field descriptions

	Working with target applications
	Targets workspace
	Targets workspace—Field descriptions

	Working with sponsors
	Sponsors workspace
	Creating a sponsor
	Deleting a sponsor
	Importing sponsor information
	Exporting sponsor information
	Sponsors workspace—Field descriptions

	Working with system settings
	System Settings workspace
	Importing, exporting, and deleting system settings

	Working with in-place revision settings
	In-place Revisions workspace
	In-place Revisions workspace—Option descriptions

	Working with note types and task types
	Adding, modifying, and deleting a collaboration note type
	Adding, modifying, and deleting a task type
	Note Types and Task Types workspaces
	Note Types workspace
	Task Types workspace
	Note Types workspace—Field descriptions
	Task Types workspace—Field descriptions


	Working with custom properties
	Adding, modifying, and removing a custom property
	Adding and removing a grouping
	Moving, cutting, copying, and pasting a grouping
	Custom Properties workspace
	InForm and Clintrial custom properties
	Custom properties in the Central Designer application
	Custom Properties workspace—Field descriptions

	Working with report definitions
	Exporting the file for report definitions
	Updating report definitions
	Reports Definitions workspace

	Working with units definitions
	Exporting and importing a units file
	Units Definitions workspace

	Working with coding information
	Importing and overwriting a dictionary type
	Enabling and disabling a dictionary type
	Renaming a dictionary type
	Adding, modifying, and deleting a verbatim type
	Importing and overwriting dictionary metadata
	Dictionary Types workspace
	Verbatim Types workspace
	Coding Dictionary Metadata workspace
	Dictionary Types workspace—Field descriptions
	Coding Dictionary Metadata workspace—Option descriptions

	Working with security settings
	Changing the security settings for accounts and sessions
	Security Settings workspace
	Security Settings workspace—Option descriptions

	Working with deployment options
	Deployment Server Types workspace
	Reason Text workspace
	Deployment Server Types workspace—Option descriptions
	Deployment Reason Text workspace—Option descriptions


	Catalog administration
	Checklist—Creating and using keywords and categories
	Working with a catalog
	Searching a catalog for a keyword
	Creating and deleting a keyword
	Copying a keyword
	Creating and removing a category
	Cutting, copying, or pasting a category
	Workflow for categorizing users with categories and keywords

	About the Catalog workspace
	Types of keywords and categories


	Server management administration
	Working with event log messages for a web farm
	Working with Event Log messages for a web farm
	Event Log Messages workspace

	Working with a web farm and the primary job scheduler
	Determining and changing the primary job scheduler
	Viewing the servers that are in the web farm
	Removing a server from a web farm
	Checking whether the primary Job Scheduler service is running
	Viewing job properties and cancelling a job in the Job Scheduler queue
	Job Scheduler workspace
	Setting the polling interval for retrieving the status of deployment


	Reference information
	Keyboard shortcuts
	Keyboard shortcuts for opening menus
	Keyboard shortcuts for the Users workspace
	Keyboard shortcuts for the Roles workspace
	Keyboard shortcuts for the Custom Properties workspace
	Keyboard shortcuts for the Catalog workspace

	Status toolbar—Option descriptions

	Rights descriptions
	Roles workspace—Right descriptions
	Application roles—Right descriptions
	Application Administration
	Archive Administration
	Catalog Administration
	Coding Dictionaries Administration
	Collaboration Administration
	Custom Properties Administration
	Deployment Administration
	In-place Revisions Administration
	Language Library Administration
	Library Administration
	Locales Administration
	Reports Administration
	Role Administration
	Search
	Security Settings Administration
	Sponsors Administration
	Study Administration
	Units Administration
	User Administration
	Verbatim Types Administration
	Web Farm Administration

	Library roles—Right descriptions
	Library Administration
	Library Collaboration
	Library Design
	Library Help
	Library Import Export
	Library Import Export Translations
	Library Jobs Browser
	Library Logical Schemas
	Library Rule Design
	Library Translation

	Study roles—Right descriptions
	Study Administration
	Study Annotated Studybook
	Study Collaboration
	Study Deployment
	Study Design
	Study Help
	Study Import Export
	Study Import Export Translations
	Study Jobs Browser
	Study Logical Schema
	Study Rule Design
	Study Translation


	Adding units and conversion calculations
	About units and conversion calculations
	Unit XML definition
	Conversion calculation XML definition
	Editing the units file
	Units defined in the units file
	Conversion calculations defined in the units file
	Supported locales and their abbreviations

	Glossary
	annotated study book
	application role
	arm
	authentication
	authorization
	automated deployment
	baseline
	Baselines Browser
	branch
	calculation rule
	catalog
	catalog administration
	category
	CDISC
	checkbox
	clinical project
	clinical protocol
	clinical study
	codelist
	codelist item
	coding
	coding dictionary
	coding map
	coding target
	collaboration
	collaboration note
	collaboration note type
	Collaboration Notes Browser
	common form
	component
	compound item
	constant
	constraint rule
	container
	context item
	CSML
	custom data dimension
	custom property
	data dimension
	data series
	data set
	data type
	data-entry rule
	date time item
	deployment
	deployment approval
	deployment instance
	deployment request
	dictionary metadata item
	dictionary type
	drop-down list
	dynamic form
	dynamic visit
	edit check
	element
	event
	explicit lock
	expression
	field
	float item
	form
	full installation deployment package
	function
	global condition
	globals
	grouping
	implicit lock
	incremental deployment package
	in-place revision (IPR)
	integer item
	internationalization
	intrinsic rule
	item
	item group
	Job Log Browser
	keyword
	Libraries Browser
	library
	Library List
	library project
	library role
	library team
	locale
	localization
	locked
	mapping
	MedML
	method
	normalization
	object
	ODM
	precondition
	project
	Project Explorer
	Properties Browser
	property
	protocol
	publish
	query
	query group
	radio button
	reference
	RefName
	repeating form
	repository
	revision
	right
	rights group
	role
	role administration
	rule
	rule action
	rule scope
	rule template
	rule type
	SDTM
	shared form
	signature group
	site
	sponsor
	standard data dimension
	standard task type
	study
	study administration object
	study arm
	study book
	study branch
	study configuration
	study design
	study element
	study event
	study object
	study object editor
	study project
	study role
	study team
	study workflow
	subject
	system
	system configuration administration
	target item
	task
	task classification
	task type
	Tasks Browser
	team
	template
	text box
	text item
	translation task type
	type
	unpublish
	user
	user administration
	user role
	Users Browser
	validation
	verbatim
	verbatim type
	version
	visit
	workflow
	workflow rule
	workspace
	yes no item

	Index

